NETWITNESS’
PLATFORM

Live Services Management Guide
for RSA NetWitness® Platform 11.3




Live Services Management Guide

Copyright © 1994-2021 Dell Inc. or its subsidiaries. All Rights Reserved.
Contact Information

RSA Link at https://community.rsa.com contains a knowledge base that answers common questions and
provides solutions to known problems, product documentation, community discussions, and case
management.

Trademarks

For a list of RSA trademarks, go to https://www.rsa.com/en-us/company/rsa-trademarks.
License Agreement

This software and the associated documentation are proprietary and confidential to Dell, are furnished
under license, and may be used and copied only in accordance with the terms of such license and with
the inclusion of the copyright notice below. This software and the documentation, and any copies thereof,
may not be provided or otherwise made available to any other person.

No title to or ownership of the software or documentation or any intellectual property rights thereto is
hereby transferred. Any unauthorized use or reproduction of this software and the documentation may be
subject to civil and/or criminal liability.

This software is subject to change without notice and should not be construed as a commitment by Dell.
Third-Party Licenses

This product may include software developed by parties other than RSA. By using this product, a user of
this product agrees to be fully bound by terms of the license agreements applicable to third-party
software in this product.

Note on Encryption Technologies

This product may contain encryption technology. Many countries prohibit or restrict the use, import, or
export of encryption technologies, and current use, import, and export regulations should be followed
when using, importing or exporting this product.

Distribution

Dell believes the information in this publication is accurate as of its publication date. The information is
subject to change without notice.

April 2021



https://community.rsa.com/
https://www.rsa.com/en-us/company/rsa-trademarks

Live Services Management Guide

Contents
Live Services Management ... .. 6
NetWitness Platform Live ... L 6
The CMS Library ... o 6
NetWitness Platform Feedback and Data Sharing ... ... ... . ... .. ... 6
Live Services Required Procedures ... ... . ... . 7
Create Live ACCOUNT ... . . 8
Reset the Password for Your Live Account ... . ... .. 11
Set Up Live Services on NetWitness Platform ... . ... 12
Find and Deploy Live Resources .. ... ... .. . ... 13
Deploy Resources in Live ... .. 14
Manage Live ReSOUICES .. ... 19
ProcedUres ... oL 19
Manage Subscription and Deployment - ... 19
Remove a Deployed Resource ... .. . . .. 20
Deploy a Resource Bundle ... .. 20
Download ResOUICes ... ... L 20
Set Up Data Feeds ... L 20
Search and Download Content from NetWitness Platform Live ... ... ... ... ... _............... 21
Quick Search for Content .. L 21
Advanced Search for Content .. ... il 21
Download Content ... .. .. 23
Additional Procedures ... ... . 24
Export Data to RS A il 25
About Live Feedback ... ... . .. 25
Download Live Feedback Historical Data ...... ... ... .. ... 25
Share Data to RS A 26
Packaging ResourCes ... ... .. o .. 26
Create and Deploy Resource Package Use Case ... i 26
Prerequisites to Create a Resource Package ... ... ... . ... 27
Creating a Resource Package ... ... ... ... 27
Creating Threat Package ... ... . 27
Deploying a Threat Package ... ... ... ... 28
Manage Custom Feeds ... L 30
Custom Feed Creation ... ... .. 30
Sample Feed Definition File - .. 30




Live Services Management Guide

Feed Definition Equivalents for Custom Feed Wizard Parameters ........_........................... 31
Creating a Custom Feed ... 33
MetaCallback Feeds using CIDR Index Range for IPv4 and IPv6 ... 42

Create a STIX Custom Feed ... il 43
MetaCallback Feeds using CIDR Index Range for IPv4 and IPv6 ... 53
Creating and Managing an Identity Feed ... .. .. .. ... 54
Import the SSL Certificate ... .. . 62

Cannot Verify Identity Feed URL ... ... 62
Investigating an Identity Feed ... ... 63

Editing a Feed ... . 64
Removing a Feed ... .. . . 66
Subscribing to Live ReSOUICes ... .. 67
Subscription Updates ... ... ... 68
Adding Subscribed Resources for Deployment to Services ...... ... 69
Deleting a SubsCription ... ... 69
Removing Subscribed Resources from the Deployments Subscriptions Grid ...................... .. 70
Subscribe and Unsubscribe to a Resource ... ... . ... 70
Viewing Subscribed Resources Selected to Deploy on Services ............... ... .................. 72
Miscellaneous Live Services Procedures ... ... . ... .. 72
Displaying Resource Details in Live Resource View ... ... ... ... .. ... 72
Downloading a ReSOUICe . ... ... ... . 73
Locating and Removing a Deployed Resource from Services ......................................... 73
Showing Results as a List or in Detail .. ... . 74
Viewing Resource Details ... 75
ReferenNCes 77
Live Configure VieW .. il 77
Deployments Tab .. .. L 77
Groups Panel . 78
Subscriptions Panel ... 78
Subscriptions Tab .. ... . 79
Toolbar ... 80

L 55 o 80
Discontinued Resources Tab ... ... . 81
Groups Panel . il 82
Discontinued Resources on Service Panel ... ... ... 82

Live Feeds VieW ... 82
T 00 AT 83
Feeds Grid ... 84
Live Resource VIeW ... .. 84
Resource Details ... ... ... 85




Live Services Management Guide

Resource View Toolbar ... ... L 87
Live Search VieW il 87
Search Criteria Panel ... i 88
Matching Resources Panel ... ... . 90
Detailed Results ... il 90

Grid ReSUItS .. L 91

See AlSO oL 92

Live Search Content VieW .. 92
Search Content Panel ... L 93
Search Results Panel ... . 95
Content Details Panel ... . 96
Resource Package Deployment Wizard ... .. 98
Features il 99
Package Tab ... ... 99
Resources Tab il 100
Services Tab .. 100
Review Tab . 101
Deploy Tab 102
RSA Live Registration Portal ... il 103
NetWitness Platform Feedback and Data Sharing ... .. ... ... . 105
Additional Live Services ... ...l 105
Live Feedback .. ... . 105
RSA Live Connect ...l 105
Threat Insights _ . . 106

Analyst Behaviors ... 107
DS eI P ION 107

File Reputation .. ... ... 108
Participation in RSA Live CONNeCt .. ... 108
Cloud Authentication ... ... il 108
Configuration ... ... . 108

Data Collection ... .. . 108
Example ..o 109
Troubleshooting Live Services ... ... 110
OutOfMemoryError on Context Hub Server ... . . . 110
Troubleshooting Live Connect Threat Data Sharing ... ... .. .. . ... ... 110
Query Log Retrieval Sample ... ... 111
System Logging: Debug . . 111




Live Services Management

RSA NetWitness Platform Live is the gateway to a rich environment that offers access to feeds, tools,
and other resources.

NetWitness Platform Live

Live is the component of NetWitness Platform that manages communication and synchronization
between NetWitness Platform services and a library of Live content available to RSA NetWitness
Platform customers. Live provides a simple interface for browsing, selecting, and deploying content from
the NetWitness Platform Live Content Management System to NetWitness Platform services and
software. In addition to managing feeds from the CMS Library, Live allows users to deploy custom
feeds and packages.

Note: Any customer with valid maintenance can access RSA Live.

The CMS Library

The content management system (CMS) library (known as Live) is a valuable source of the latest
internet security resources for NetWitness Platform customers. It provides a view into the collective
intelligence and analytical skills of the worldwide security community to ensure that users have the most
current visibility into attack vectors.

Live gathers the best advanced threat intelligence and content in the global security community - the
ideas, research, ongoing tracking, and analysis - and brings it directly into the user’s security operations
center to definitively classify computers associated with botnets, malware, and other malicious exploits.
Live aggregates, consolidates, and illuminates only the most pertinent information relevant to an
organization on a real-time basis.

NetWitness Platform Feedback and Data Sharing

Live Feedback is intended to help improve RSA NetWitness Platform. Once you set up and configure a
Live account, usage data is shared with RSA.

RSA Live Connect is a cloud based threat intelligence service. This service collects, analyzes, and
assesses threat intelligence data such as IP addresses, domains, and files collected from various sources.
It is Threat Insights, which provide analysts the ability to pull threat intelligence data from the Live
Connect service. It also offers Analyst Behaviors, an automated data collection service with the goal of
sharing potential threat intelligence for analysis.

For more details, see NetWitness Platform Feedback and Data Sharing.
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Live Services Required Procedures

The following workflow describes the basic setup into four steps, which you perform individually.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

Create Live Account Create a Live Account on the RSA Live Registration portal
URL: https://cms.netwitness.com/registration/. If you have an existing
account, you can manage your account using this portal.

Set Up Live Services on  Set Up Live Services on NetWitness Platform by configuring a connection
NetWitness Platform with the CMS server.

Find and Deploy Live Search and browse for resources in the Live Search view, and then, deploy
Resources the selected resources.

Manage Live Resources Procedures for administrators to search for, subscribe to, and deploy
resources from Live.

Search and Download Search and browse for contents in the NetWitness Platform Live, and then,
Content from download the selected contents.

NetWitness Platform

Live

NetWitness Platform Describes the feedback and data sharing features provided in RSA

Feedback and Data NetWitness® Platform, from Live Services. Participation is optional, but
Sharing can help to provide useful threat intelligence for the community.

Live Services Required Procedures 7
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Create Live Account

Note: The RSA Live Registration Portal now has a new user interface and supports email verification.

Y ou must create a Live account using the RSA NetWitness Platform Live Registration Portal
(https://cms.netwitness.com/registration/) on the CMS server. Live Account is required to access all
Live services including CMS. The CMS Library provides access to all RSA content in one place where
you can view, search, deploy, and subscribe to RSA content.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

Make sure the following are available to set up a RSA Live account:

o Active internet connection to access the portal.

o A valid and registered NetWitness Platform License Server on the Flexera Server, before you can
register for a Live account. You can view the License ID on the Admin > System > Info panel.

Note: If the License Server is not set up, contact RSA customer support.

To create a Live Account:

1. Access the RSA NetWitness Platform Live Registration Portal using the URL:

https://cms.netwitness.com/registration/

Note: You can alternatively use the new URL : https://live.netwitness.rsa.com/registration/

The RSA NetWitness Platform Live sign up page is displayed.

8 Live Services Required Procedures
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RSA
NETWITNESS'

PLATFORM LIVE

Sign in with your username and password

Username *

Password *

SIGN IN

2. Click Sign Up For Live.
The License Agreement page is displayed.
Read the Terms and Conditions carefully and click Accept.

Welcome to RSA Live Registration Portal

Thank you for using RSA NetWitness.
Please sign up here for your RSA Live account to access your subscription content.

End User License Agreement

THIS SOFTWARE CONTAINS COMPUTER PROGRAMS AND OTHER PROPRIETARY
MATERIAL AND INFORMATION, THE USE OF WHICH IS SUBJECT TO AND EXPRESSLY
CONDITIONED UPON ACCEPTANCE OF THIS END USER LICENSE AGREEMENT (THE
“AGREEMENT” OR “CSA”").

THIS AGREEMENT IS A LEGALLY BINDING DOCUMENT BETWEEN YOU (MEANING THE
INDIVIDUAL PERSON OR THE ENTITY THAT THE INDIVIDUAL REPRESENTS THAT HAS
OBTAINED THE SOFTWARE AND HARDWARE FOR ITS INTERNAL PRODUCTIVE USE AND
NOT FOR OUTRIGHT RESALE) (THE “CUSTOMER”) AND RSA (WHICH MEANS (I) IF
CUSTOMER IS LOCATED IN THE UNITED STATES, MEXICO OR SOUTH AMERICA, THEN
THIS IS A LEGAL AGREEMENT BETWEEN THE CUSTOMER AND RSA WITH “RSA”
MEANING RSA SECURITY LLC. IF CUSTOMER IS LOCATED OUTSIDE OF THE UNITED

ACCEPT

3. Inthe Sign Up for RSA Live Account page, enter all the fields:
o The First Name and Last Name of the user.
o The Company for which the Live Account is being created.

o The Email address you enter will be used to receive the verification code for your new Live
account and other notifications related to the Live account.
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e The License ID can be viewed on Admin > System > Info panel.

e The Username and Password for the Live Account.

RSA |
NETWITNESS'

PLATFORM LIVE

Sign Up for RSA Live Account @

First Name

Last Name

Company

License ID

Username

Password

CREATE ACCOUNT

4. Click Create Account.
You will be directed to Confirm Sign up page.

5. Enter the Confirmation Code sent to your registered email address.
Click Confirm.

You can see the confirmation message for your RSA Live Account registration.

Note: You can create more than one Live account for the same License ID.

6. Once the account is created, enter your credentials and click Sign In to access the RSA NetWitness
Platform Live.

7. After you sign in, you can perform the following:

o Search and Download Content from NetWitness Platform Live

o Share Data to RSA

10 Live Services Required Procedures
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Reset the Password for Your Live Account

If you want to reset the password for your Live Account, do the following:

1. Access the RSA NetWitness Platform Live Registration Portal using
the URL: https://cms.netwitness.com/registration

Note: You can alternatively use the new URL : https://live.netwitness.rsa.com/registration/

The RSA NetWitness Platform Live sign up page is displayed.

RSA
NETWITNESS'

PLATFORM LIVE

Sign in with your username and password

Username *

Password *

SIGN IN

2. On the Sign Up page, click Forgot Password?

3. Enter your Username and click Send Code.
A verification code will be sent to your registered email address.

4. Enter the Verification Code and New Password on the Reset Password page and click Submit.

Live Services Required Procedures
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Set Up Live Services on NetWitness Platform

To set up Live on NetWitness Platform, you configure the connection and synchronization between the
CMS server and NetWitness Platform. The user interface for this setup is the ADMIN > System > Live
Services Configuration panel.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

To configure the connection to the CMS Server:
1. Navigate to ADMIN > System > Live Services.

2. Click Sign In and enter your credentials in the Live Services Account dialog box.

Live Services Account

Host cms.netwitness.com

Port 443

S5L ™
Username admin
Password FEEE A

Test Connection

Cancel Apply

3. Click Test Connection to make sure your connection is working.

4. If the test is successful, click Apply. If not, contact RSA Customer Support for help connecting to
the Live server.

5. Configure the timing for synchronization of NetWitness Platform with updates from Live.

For more details, see the "Configure Live Services Settings" topic in the System Configuration Guide.

12 Live Services Required Procedures
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Find and Deploy Live Resources

Administrators can search for resources in the Live Search view, which is also the same as browsing the
Live CMS for resources using the Search Criteria panel of the Live Search View.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

Search/Download ‘(Optlonal)
i Configure Feedback
Live Content

& Data Sharing

To find resources:

1. Inthe Search Criteria panel, specify search criteria. Enter any or all of these: keyword, category,

type of resource, medium, meta keys, meta values, date resource was created, and date resource was
modified.

Search Criteria

Keywords

Category
[CIFEATURED

» I THREAT

» CTIDENTITY

» CIASSURANCE

» CIOPERATIONS

Rescurce Types
Medium

Required Meta Keys
Generated Meta Values

Resource Created Date:

Start Date End Date

Resource Modified Date: v

2. Click Search.

The Matching Resources panel displays detailed results.

Live Services Required Procedures 13
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RSA CONFIGURE J @ admin© @

LIVE CONTENT

Search Criteria Matching Resources
Keywords Show Results = | | 3 Package ~
malware .
By Malware Domains
Catagory 2 .
- type Feed 017-07-19 1:02 AM version 0.869 size 2.11 MB subscribed yes
I FEATURED List of domains associates with malware sourced from v alwaredomains.com.
» CITHREAT @ threat. malware £ threat.category, threat.desc, threat.source [ malwaredomains.com
» CTIDENTITY

are Domain List

By Mah

» C1ASSURANCE

type Feed updated 2017-07-17 12:40 AM version 0.1490 size 85.91 KB subscribed no
» [ GPERATIONS List of domains commonly associated with malware sourced from www.malwaredomainlist.com
@ threat, malware £ threat.category, threat.desc, threat.source [§ malwaredomainlist-domain
Resource Types
M By Malware IP List
4 type Feed updated 2017-07-17 12:45 AM version 0.1567 size 32,55 KB subscribed yes

Medium List of ip addresses commonly associated with malware sourced from www.malwaredomainlist.com.
~ @ threat, malware £ threat.category, threat.desc, threat.source g malwaredomainlist-ip
Required Meta Keys #4 Malware PDF
ﬂ t FlexParser updated 2012-02-09 4:51 PM version 0.1 size 17.51 KB subscribed no
Cenersted Meta Values - Legacy: Intended only for 9.8. For SA deployments version 10 and above, see lua parser fingerprint_pdf_lua Detects PDF files that contain

Javascript or launch actions

57 Matching Resources
[R'S/\ NETWITNESS' PLATFORM

3. (Optional) To further narrow the results In the Matching Resources panel, click on a tag, meta key,
medium or resource meta value in a result.

Deploy Resources in Live

In RSA NetWitness Platform, you can deploy selected resources manually, using the Deployment
Wizard, or you can subscribe to a group of resources.

o When you have results from browsing resources in NetWitness Platform Live, you can deploy
resources manually to a service or a service group without subscribing to the resources. To deploy
resources, select one or more from the list.

o Deploying resources manually deploys to services without taking advantage of the powerful resource
management capabilities of NetWitness Platform. If you want to receive notification and updates for
updated resources and be able to easily remove resources from a service, you must subscribe to
resources in the Live Search view and deploy them in the Live Configure View.

« If you have previously created and saved a resource package, you can deploy the package to services.
Please refer to Resource Package Deployment Wizard for instructions on how to create a package.

Caution: For NetWitness Platform 11.3, there is a new Content bundle for Endpoint, which contains
approximately 400 application rules. Do not deploy this bundle (or the Endpoint application rules) onto
any Log Decoder that is running an earlier version of NetWitness Platform. The rules are only useful
for 11.3 and newer, and would have major performance implications if deployed on Log Decoders that
cannot process them.

To deploy resources manually:
1. Go to CONFIGURE > Live Content.

2. Select a group of resources, or a previously created resource package.

14 Live Services Required Procedures
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To select a resource or group of resources:

a. Inthe Live Search View, browse Live resources (for example, search for the Log Collector
resource Type).

b. Inthe Matching Resources panel, select Show Results > Grid.

c. Select the checkbox to the left of the resources that you want to deploy.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Live Content  Incident Rules  Respond Notifications ~ ESA Rules  Subscriptions  Custom Feeds Log Parser Rules

Search Criteria Matching Resources
- Show Results ¥ | ‘8 Deploy A Subscribe | 3§ Package @
Category
[ subscrivea Name Created Updated Type Description
CIFEATURED
O re Windows Events (NIQ)Log...  2013-11-22 215 PM 2016-07-07 2:26 PM Log Collector Log Collector configuration can
» CITHREAT
¥ ne AWS CloudTrail Log Collec...  2015-06-16 11:38 PM 2017-06-14 7:41 AM Log Collector 105 and higher. Log Collector
» CJIDENTITY
O ne Microsoft Exchange Log Col..  2013-11-22 1:46 PM 2016-07-07 2:17 PM Log Collector Log Collector configuration con
» COASSURANCE . 9
¥ no Symantee Critical System...  2013-11-22 6:38 AM 2016-07-07 2:20 PM Log Collector Log Collector configuration cc
» CJOPERATIONS
B O ne Oracle Log Collector Config... 2016-08-26 12:04 PM Log Collector Log Collector configuration con
Resource Types O ne EMC Documentum Log Coll... 12PM Log Collector Log Collector configuration con
Log Collector @ v O re 1BM DB2 Log Collector Conf, 13 M Log Colleccor Log Collector configuration con
O ne Mchfee Web Gat 2016-07-07 2:15 PM Log Collector Log Collector configuration con
Medium
O ne Tenable Netw 2016+ Log Collector Log Collector configuration con
O ne SunOne LDAP Directory Ser.. 2016+ Log Collector Log Collector configuration con
Required Meta Keys O ne Oracl nagerlog.. 2014-0407 2017-04-1 Log Collector Log Collector configuration con
O re MS Azure Log Collector Con...  2016-08-21 1:56 PM 2017, Log Collector Log Collector configuration con
Generated Meta Values O no Mchfee Inzegrity Control Lo 2013-11-22 6:26 AM 2017+ Log Collector Log Collector configuration con
O ne Actiance Vantage Log Colle..  2012-11-22 6:00 AM Log Colleccor Log Collector configuration con
— R _— . [ R R . ,
Search
- 170 Matching Resources

RS /\ NETWITNESS' PLATFORM 11.3.0.0

d. In the Matching Resources toolbar, click 2. DeRIoy
Deployment Wizard

Resources Services Review

Total resources: 2

Resource Names Resource Type Dependency of
Symantec Critical Systems Protection Log Colle...  Log Collectar

AWS CloudTrail Log Cellector Cenfiguration Log Collector

Cancel MNext

3. To select a resource package to deploy:
a. Inthe Live Search view - Matching Resources toolbar, select Package > Deploy .

The Package page of the Resource Package Deployment wizard is displayed.

Live Services Required Procedures 15
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Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle Browse

Cancel Next

b. Click Browse and select a package from your network (for example resourceBundle-
FeedsParsersContent.zip).

c. Click Open.

At this point, whether you are deploying a package or a group of resources, the Deployment
Wizard opens, and the Resources page is displayed.

4. Click Next.

The Services page displayed has two tabs, Services and Groups, which provide a list of services
and service groups that are configured in the ADMIN > Services view. The columns are a subset of
the columns available in the Services view.

Note: The Live server is "smart" about deploying resources to Services. For example, it does not
deploy resources that have a Medium of packets to any Log Decoders. This means that only
applicable content resources are deployed to each Service.

5. Select the services on which you want to deploy the content. You can select any combination of
services and service groups.

o Use the Services tab to select individual services, list of services, and service groups that are
configured in the ADMIN > Services view.

o Use the Groups tab to select groups of services.

16 Live Services Required Procedures
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Deployment Wizard

Resources Services Review Deploy
[ ﬁ' Mame ~ Type
[l # SAUIEndpoint Other

Cancel Previous Next

6. Click Next.
The Review page is displayed.

Deployment Wizard

Resources Services Deploy
Service Service Type Resource Name Resource Type
SA Ul Endpoint SA Local Basic Rule Template RSA Event Stream Analy...

Cancel Previous Deploy

Make sure that you have selected correct resources and the services on which you want to deploy
them.

7. Click Deploy.

The Deploy page is displayed. The Progress bar turns green when you have successfully deployed
the resources to the selected services.

Live Services Required Procedures 17
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Deployment Wizard

Resources Services Review

Live deployment task finished successfully

Service Name Resource Name Status Progress

54 Ul Endpoint Basic Rule Template 10f1 [ 3

Close

If you try to deploy resources and services that are not compatible, NetWitness Platform displays the
Errors and Retry buttons, which you can click to review the errors and re-attempt the deployment.

Package Resources Devices Review

Deployment in progress...

Device Name Resource Mame

Log Decoder4d  Malware Domains

8. Click Close.
Next steps

After deploying parsers to Decoders and Log Decoders, you must enable parsers on the individual
services. For more information, see the Decoder and Log Decoder Configuration Guide.
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Manage Live Resources

With a connection to the CMS server, you can search for, subscribe to, and deploy resources from Live
in accordance with your subscription level. Once you have found resources, you deploy them to services
and service groups that have been configured in the ADMIN > Services view.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

Procedures

There are several workflows for deploying resources to services and managing those deployments.
These include:

o Subscribe and deploy resources

o Deploy a resource bundle

o Remove deployments of resources
o Download resources

o Set up data feeds

Manage Subscription and Deployment

The subscription and deployment workflow takes advantage of the resource management tools available
in Live. By subscribing to resources, you agree to receive updated resources in accordance with the
synchronization configured in the ADMIN > Live Configuration panel.

By adding subscribed resources to the deployments list, you configure NetWitness Platform to
automatically push those resources to the selected services at the configured synchronization intervals.
This method requires some planning of service groups and services where resources are deployed. In
addition:

e You canremove a resource from the deployments list in the Deployments Tab.

o You can unsubscribe from a resource in the Subscriptions Tab and the Live Resource View.

Live Services Required Procedures 19
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To manage subscriptions and deployment:

1. Inthe ADMIN > System > Live Services panel, specify an interval at which NetWitness Platform
checks for updates to subscribed resources in Live and specify the email addresses of people to
receive an email listing subscribed resources that have been updated.

2. Inthe CONFIGURE > Live Content search view, search for and subscribe to Live resources.

3. Inthe CONFIGURE > Subscriptions > Deployments tab, select subscribed resources and add
them to the deployment list for services groups.

4. (Optional) In the CONFIGURE > Subscriptions > Deployments tab, click 5. to deploy the
resources listed in the Deployments tab immediately.

5. In the CONFIGURE > Subscriptions > Deployments tab, select deployed resources from a Group,
and remove them from services.

6. Inthe CONFIGURE > Subscriptions tab, unsubscribe from resources.

Remove a Deployed Resource

Once deployed to a service, Live resources remain on the service until removed. It is a good practice to
remove unused resources from services on which they are deployed.

To remove deployed resources:

1. Go to the Live Resource View,

2. Unsubscribe from a resource, and remove it from deployed services.

Deploy a Resource Bundle

To deploy a content package, use the Resource Package Deployment Wizard. You can deploy a content
package created in Live to one or more services. NetWitness Platform accepts packages in .nwp files
or .zip files.

Download Resources

To download resources to your local file system, use the Download button in the Live Resource view.

Set Up Data Feeds

In the Live > Feeds view, you can set up and maintain Custom and Identify feeds.
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Search and Download Content from NetWitness Platform Live

Administrators can search for live content using the Search Content panel in the NetWitness Platform
Live, which is similar to browsing the live CMS contents in the Configure > Live Content page on the
NetWitness Platform.

Note: If Admin server is not connected to the Live Services, you can use the NetWitness Platform
Live to search and download the required contents.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

Prerequisites

o Ensure that you have created the Live account. For more information, see Create Live Account.

Quick Search for Content

You can quickly select and view the available content types under Content section in the NetWitness
Platform Live.

Clicking ) expands the Content section and displays the following options:
o Featured: Selected by default, displays all the featured contents.

o New: Displays the content which is created in the last 21 days.

« Recently Updated: Displays the content which is updated in the last 21 days.

Advanced Search for Content

You can search for the specific content in the Search Content view. For more information, see Live
Search Content View.

To search the content:

1. Click ) to expand the Search Content section.
2. In the Search Content, specify the search criteria. Enter any or all of these: keyword, type of
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resource, tag, meta keys, meta values, date when content was created, date when content was
modified, and (optional) discontinued content.

Search Content

KEYWORDS

RESOURCE TYPES

TAGS
featured X

REQUIRED META KEYS

GENERATED META VALUES

CREATED DATE
Startda... — Enddate Ei
MODIFIED DATE

Startda... — Enddate Ei

[ Include Discontinued

Search Reset Filter

3. Click Search.
The matching results are displayed on the right panel.

& Content

View Featured, new and recently updated content details here.

Showing Filtered Content (330) Timezone : GMT+0530 Asia/Calcutta

NAME 3

CREATED §
16-May-2012 06:37:45
09-Feb-201222:18:20
09-Feb-2012 22:09:55
09-Feb-2012 22:10:05
13-Feb-201403:19:25
24-Jul-2012 10:54:16
09-Feb-2012 22:18:00
09-Feb-201222:18:19
13-Feb-2014 04:43:33

09-Feb-201222:11:47

UPDATED §
24-Nov-2020 03:40:31
11-Apr-2017 14:47:05
10-Aug-2016 01:02:50
15-Apr-2016 08:02:55
17-Jul-2019 06:30:06
24-Nov-2020 05:50:28
15-Apr-2016 08:02:54
24-Nov-202003:30:31
17-Jul-2019 07:30:05

15-Apr-2016 08:03:30

DESCRIPTION 4

This feed contains IPs known to be associated with APTs. l
This feed contains ips that represent known VPN exit nodes for criminal anon...
AlertID to name mappings for informational alerts

This feed identifies many commonly seen dynamic dns related domains

Contains domains published as malicious from third party research and public...

DROP (Don't Route Or Peer) and EDROP are advisory "drop all traffic” lists, c...

Alerts on extensions as follows: doc,xls,ppt,pdf,txt,xml

This feed contains ips that represent known VPN entry nodes for criminal ano...
Contains IPs published as malicious from third party research and publications.

whitelist domains for spectrum

You can sort the contents using the name, created date, updated date, type, or description.
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Note: Clicking Reset Filter removes the existing filters applied from the Search Content, and
displays all the available content on the right panel.

Download Content

Y ou can download the contents from the results displayed in the right panel by performing the following

steps:

Note: You cannot download a discontinued content.

To download the content:

1. Click the title of the topic that you want to download.
The Content Details dialog is displayed.

Content Details

electricfish

DEPENDENCIES

CONFIICTS

@ Large files may take longer time to start the download. Close | Download

2. Click Download.

The content file 1s downloaded.

Live Services Required Procedures
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Additional Procedures

This topic explains the additional procedures an administrator could choose to follow which are not

essential for the configuration or use of Live Services.

o Export Data to RSA

» Packaging Resources

o Manage Custom Feeds

Creating a Custom Feed

Create a STIX Custom Feed

Creating and Managing an Identity Feed

« Editing a Feed

« Removing a Feed

o Miscellaneous Live Services Procedures
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Export Data to RSA

A NetWitness Platform administrator can export the metrics in NetWitness Platform for Live Feedback.

About Live Feedback

In the Live Services Configuration panel, there is a Live Feedback Activity Log which enables you to
download the usage data required for Live Feedback. This is active regardless of the Live
Account configuration.

If the Live Account is not configured, you can manually upload the usage data to RSA. For more
information, see the "Configure Live Services Panel" topic in the System Configuration Guide.

You must first download the Live Feedback historical data, and then upload it to share with RSA.

Download Live Feedback Historical Data

To download the Live Feedback historical data:
1. Goto ADMIN > System.
2. In the options panel, select Live Services.

The Live Account screen is displayed which consists of the RSA Live Status and Download Live
Feedback Activity Log.

3. Click Download Live Feedback Activity Log.

The Download Live Feedback Activity Log window opens which allows you to download the
required Live Feedback historical data.

Live Feedback Activity Logs

Download monthly anonymized activity logs and manually upload to B5A secure portal,
For use only when live account is not configured.

Ll pate Range ~ Last Download Date

[0 2017, June30-18

| Page 1 of1 | | C PageSize 10 ~ Displaying 1-1 of 1

4. Select one or multiple entries by selecting the checkboxes and click Download.

Note: If you select multiple entries in the history table, the Live Feedback data is downloaded into
a ZIP archive, consisting of individual JSON files for each month.
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Share Data to RSA

After you download the Live Feedback data, you can then upload it using the following procedure.

Note:

- To download the Live Feedback data, see topic Download Live Feedback Historical Data.

- You can share data using the new live registration portal. For more information, Create Live
Account.

To share the data to RSA:

1. Log in to the NetWitness Platform Live using your credentials.

2. Click on the left panel.
The Telemetry Logs dialog is displayed.

X, Telemetr

Upload Live Feedb:

-and-drop the zip file to upload.

Note:
- You can upload only .zip files.
- Filename must be 255 characters or less and file size must be less than 128 MB.

3. Click or drag-and-drop a file onto this area to upload.

Packaging Resources

The primary use for creating and subsequently deploying a resource package is for customers using an
air gap network environment. In this case, you create a resource package on the network that is
connected to the internet, and then deploy the resource package on a more secure network.

Create and Deploy Resource Package Use Case

The basic steps are as follows:
1. Access NetWitness Platform Live Services using an instance that is connected to the internet.
2. Create a Resource package as described below, adding whichever content items you need.

3. Copy the ZIP archive of the packages to your secure NetWitness Platform instance, by using a thumb
drive or other manual copying process.
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4. On the secure NetWitness Platform instance, deploy the resource package. For more information,
see Resource Package Deployment Wizard.

Prerequisites to Create a Resource Package

A prerequisite for creating resource packages is configuration of the connection and synchronization
between the CMS server and NetWitness Platform and the ability to search for resources in the User
Interface.

Creating a Resource Package

The following procedure describes how to create a resource package, as a ZIP archive and save it to
your local file system.

To create a resource package:
1. Go to CONFIGURE > Live Content from the RSA NetWitness UI.

2. Select the resources that you want to package in the Matching Resources grid.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE  ADMIN N @ admin
Live Content Incident Rules  Respond Notifications  ESA Rules  Subscriptions  Custom Feeds Log Parser Rules
Search Criteria Matching Resources
- Show Results = | S Deploy A Subscribe | 3 Package ©
Category
[ | subscribed Name Created Updated Type Description
[CJFEATURED
O re Windows Events (NIC) Log .. 2013-11-222:15 PM 2016-07-07 2:26 PM Log Collector Log Callector configuration con
b CITHREAT
™ ne AWS CloudTrail Log Collec... 2015-06-16 11:38 PM 2017-06-14 7:41 AM Log Collector 10.5 and higher. Log Collector
» CJIDENTITY
= O ro Microsoft Exchange Log Col..  2013-11-22 1:46 PM 2016-07-07 2:17 P Log Cllector Log Collector configuration con
b CIASSURANCE . i
¥ ne Symantec Critical System...  2013-11-22 6:38 AM 2016-07-07 2:20 PM Log Collector Log Collector configuration cc
» CJOPERATIONS 121199 27 A 016.0: 0 i
O ne Oracle Log Callector Config..  2013-11-226:32 AM 2016-08-26 12:04 PM Log Collector Log Collector configuration con
Resource Types O no EMC Decumentum Log Coll...  2013-1 Log Callector Log Collector configuration con
Log Collector & 0O no 1BM DB2 Log Collector Conf...  2013-1 Log Collector Log Callector configuration con
O no McAfee Web Gateway Log..  2013-1 Log Collector Log Callector configuration con
Medium 0131133 6:30 A
O no Tenable Nework Security .. 2013-11-22 6:30 AM Log Collector Log Callector configuration con
O no SunOne LDAP Directory Ser... 20131 M Log Cllector Log Collector configuration con
Required Meta Keys O re Oracle Access manager Log...  2014-04-07 5:03 AM Log Collector Log Callector configuration con
O ne M Azure Log Collector Con...  2016-08-21 1:56 PM Log Collector Log Collector configuration con
Generated Meta Values O no MeAfee Integrity Contral Lo... 20131 M Log Callector Log Collector configuration con
O re Actiance Vantage Log Colle..  2013-11-226:09 AM Log Collector Log Callector configuration con
o - - T 3
m 170 Matching Resources

RS /\ NETWITNESS' PLATFORM 11.3.00

3. Select some or all the resources that are listed in the Matches Resources pane.

4. Select * Package * > Create.

NetWitness Platform creates a .zip archive that contains the selected resources and downloads it to your
default download folder. NetWitness Platform gives the package a generic name. Y ou should rename it
when you save it so that it identifies the resources contained in the package.

Creating Threat Package

The following procedure describes how to create a resource package that contains all the content that is
categorized as Threat. Then we rename it, using the type of content and date.

1. Go to CONFIGURE > Live Content.
2. From the Category section, select THREAT.
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3. Select all items returned by clicking on the checkbox in the column header row of the Matching

Resources pane.

RSA| RESPOND

Live Content

INVESTIGATE

MONITOR

CONFIGURE

ADMIN

'j) admin & @

Search Criteria

» CJIDENTITY

b [ ASSURANCE
» [ OPERATIONS
I SPECTRUM
[ MALWARE ANALYSIS

Resource Types

Required Meta Keys

Matching Resources

FEEERREREER

=

Aggressive Internal NetBIOS scan
Aggressive internal web portal sc...
Alert IDs By Profiled Source IP
Alerts By Profiled Source IP

All Risk Suspicious

All Risk Suspicious by Destinatio...
All Risk Suspicious by Session Size
All Risk Suspicious by Source IP

All Risk Warning

All Risk Warning by Destination IP

Behaviors of Compromise

Keywords E5 Show Results © | '8’ Deploy | 3 package ©
[ ™} Name ~ Type Description
[¥ Aggressive Internal Database Scan  Event Stream Analysis Rule Detects a single host making connection attempts to 100 or more unigu

Event Stream Analysis Rule
Event Stream Analysis Rule
NetWitness Rule
NetWitness Rule
NetWitness Report
NetWitness Rule
NetWitness Rule
NetWitness Rule
NetWitness Report

NetWitness Rule

[¥ All Risk Warning by Session Size NetWitness Rule Aggregates sessions by risk.warning and displays all results by session ¢

- [¥ Al Risk Warning by Source IP NetWitness Rule Aggregates sessions by risk.warning and displays all results by ip.srcin

Medium [¥  apt_artifacts Lua Parser Detects possible apt WMI and windows registry manipulation. DEPENDE
~ [¥  Archive From IP Address Application Rule archive directly from an ip address with no corresponding alias.host me

¥ Backdoor Activity Detected Event Stream Analysis Rule  The rule will detect backdoor activity using logs. By default, the rule wil

NetWitness Rule

Detects a single host making connection attempts ta 100 or more unigu
Detects a single host making connection attempts ta 100 or more unigu
Detects the meta key alert.id generated through basic correlation rules
Detects the meta key alert generated through application rules, which

This report lists All Risk Suspicious by Source, Destination and Session §
Aggregates sessions by risk.suspicious and displays all results by ip.dst

Aggregates sessions by risk.suspicious and displays all results by sessio
Aggregates sessions by risk.suspicious and displays all results by ip.src |
This report lists All Risk Warning by Source, Destination and Session Siz

Aggregates sessions by risk.warning and displays all results by ip.dst in

Designated for suspect or nefarious behavior outside the standard sign

3

233 Matching Resources
[R'S/\ NETWITNESS' PLATFORM 11.2.0.0

4. Select * Package * > Create.

A ZIP archive is saved to your Downloads folder. For example,
resourceBundle8740753704980701969.zip.

5. Rename the package to something meaningful. For example, in this case, you cold change the
package name to threatResourceBundle_2018 01 31.zip (assuming today's date is January 31,
2018).

The resource package is now available for later deployment.

Deploying a Threat Package

This procedure assumes that you saved a package named threatResourceBundle 2018 01 31.zip, as
described in the previous section. It describes how to deploy a saved resource package

1. Go to CONFIGURE > Live Content.

2. In the Matching Resources pane, select A Package © > Deploy.

3. Click Browse and navigate to the threatResourceBundle 2018 01 31.zip file that were created
earlier.
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Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle | threatRescurceBundle_2018_01_31.zip Browse

Cancel

4. Click Next.
The Resources page displays details for the resources in the package.
5. Click Next.

The Services page displays two tabs, Services and Groups, which provide a list of services and
service groups that are configured in the ADMIN > Services view. The columns are a subset of the
columns available in the Services view.

6. Select the services on which you want to deploy the content. You can select any combination of
services and service groups.

Deployment Wizard

Resources Services

L] ﬂ’ Name ~ Type
Ll # SAUIEndpoint Other
Cancel Previous Mext
Click Next.

The Review page is displayed.

Note: Make sure that you have selected correct resources and the services to which you want to
deploy them.

7. Click Deploy to complete the deployment process. Alternatively, you can choose Cancel or
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Previous to either cancel the deployment or go back to the previous screen.

Manage Custom Feeds

The custom feed capability is implemented using the Custom Feed Wizard in RSA NetWitness Platform,
allowing you to quickly populate Decoders with custom and identity feeds.

Custom Feed Creation

You can use the Live > Feeds > Setup Feed > Configure a Custom Feed wizard to create and deploy
Decoder feeds based on deterministic logic that offers the meta keys specific to the selected Decoders
and Log Decoders. Although the wizard guides you through the process to create both on-demand and
recurring feeds, you should understand the form and content of a feed file when you create a feed.

Feed file names in RSA NetWitness Platform are in the form <filename>. feed. To create a feed,
NetWitness Platform requires a feed data file in . csv or .xm1 (for STIX) format and a feed definition
file in . xm1 format, which describes the structure of a feed data file. The Configure a Custom Feed
wizard can create the feed definition file based on a feed data file, or based on a feed data file and the
corresponding feed definition file.

The files that you use to create an on-demand feed must be stored on your local file system. The files
used to create a recurring feed must be stored at an accessible URL, whence NetWitness Platform can
fetch the most current version of the file for each recurrence. After a NetWitness Platform feed is
created, you can download the feed to your local file system, edit the feed files, and edit the NetWitness
Platform feed to use the updated feed files.

Sample Feed Definition File

This is an example of a feed definition file named dynamic_dns.xml, which NetWitness Platform
creates based on your entries in the Feed wizards. It defines the structure of the feed data file named
dynamic dns.csv.

Note: The feed file path should be .csv regardless of the Feed Type (Default or STIX).

<?xml version="1.0" encoding="utf-8"?>
<FDF xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalocation="feed-definitions.xsd">

<FlatFileFeed name="Dynamic DNS Domain Feed"
path="dynamic dns.csv"

separator=","

comment="4#"

version="1">

<MetaCallback
name="alias.host"
valuetype="Text"
apptype:" O "
truncdomain="true"/>

<LanguageKeys>
<LanguageKey name="threat.source" valuetype="Text" />
<LanguageKey name="threat.category" valuetype="Text" />
<LanguageKey name="threat.desc" valuetype="Text" />
</LanguageKeys>

30 Additional Procedures



Live Services Management Guide

<Fields>

<Field index="1" type="index" key="alias.host" />
<Field index="4" type="value" key="threat.desc" />
<Field index="2" type="value" key="threat.source" />
<Field index="3" type="value" key="threat.category" />

</Fields>

</FlatFileFeed>

</FDF>

Feed Definition Equivalents for Custom Feed Wizard Parameters

The NetWitness Platform Feeds wizard provide options to define the structure of the data feed file.
These correspond directly to attributes in the feed definition (.xml) file.

NetWitness
Platform

Parameter

Feed Type

Feed Task Type

Name

File/ Browse

(STIX, Recurring)

Trust All
Certificate

(STIX, Recurring)

Certificate/Browse

XML Feed File

Separator

Feed Definition File Equivalent

Define Feed tab

Select: Default - to define a feed based on a - csv formatted feed data file.
STIX - to define a feed based on STIX formatted - xml file.

Select: Adhoc - to create an on-demand feed. Recurring - to create a feed that
recurs automatically.

Enter a custom feed name in the feed data file that corresponds to the
flatfeedfile name attribute in the feed definition file; for example,
Dynamic DNS Test Feed,

Enter a name of the feed data file that corresponds to the flatfeedfile path
attribute in the feed definition file; for example, dynamic_dns.csv.

Select Trust All Certificate, if you do not want to validate the REST server
certificate. This option is enabled by default (checked).

For client authentication with the REST URL, in the Certificate field, click
Browse and select the self signed certificate. The supported certificate formats
are .cer, .crt with Base64 & DER encoded files.

Define Feed tab - Advanced Options
Enter a name of the feed definition file, for example, dynamic_dns.xml,

The separator character used to separate attributes in the feed data file. It
corresponds to the flatfeedfile separator in the feed definition file; for
example, a comma.
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NetWitness
Platform

Parameter

Comment

Remove STIX data

older than

Select Services tab

(Define Columns
tab, Define Index)
Type

(Define Columns

tab, Define Index)
CIDR

(Define Columns
tab, Define Index)
Service Type

(Define Columns

tab, Define Index)
Truncate Domain

(Define Columns
tab, Define Index)
Callback Keys

Feed Definition File Equivalent

The character used to identify a comment in the feed data file. It corresponds to
the flatfeedfile comment attribute in the feed definition file; for example,
#,

The number of days for which the STIX packages downloaded from TAXII
server have to be stored. The STIX packages older than the specified number of
days are deleted automatically. The default value is 180 days, which is also the
maximum.

Select the services to which you want to send the data feed.

The type of lookup value in the index position of the feed data file.

IP means that each row in the feed data file contains an IP address in the lookup
value position. The IP value is in dotted-decimal format (for example,
10.5.187.42).

IP Range means that each row in the feed data file contains a range of IP
addresses in the lookup value position. The IP range is in CIDR format (for
example, 192.168.2.0/24). Non IP means that the each row in the feed data file
contains a metadata value other than [P address in the lookup value position.

The Service Type and Truncate Domain, and Callback Keys fields become
active for a Non IP index.

Specifies that the IP value in the lookup position is in CIDR format. The CIDR
attribute sets the IP address format in the field to Classless Inter-Domain
Routing (CIDR) notation.

For a Non IP index, the integer service type to filter meta lookups. It
corresponds to MetaCallback apptype attribute in the feed definition file. A
value of 0 indicates no filtering by service type.

For a Non IP index, for meta values that contain domain names (for example,
hostnames), the system can strip off the host specific element in the data.
Truncate Domain corresponds to the MetaCallback truncdomain attribute. If
the value is www.example.com, it is truncated to example.com. A value of
False selects no truncation, and True selects truncation.

For a Non IP index, the available meta keys to match on instead of ip.src/ip.dst
(the defaults for IP index type) are selectable from the drop-down list.

The Callback Key corresponds to the MetaCallback name attribute, and

the index column of the csv file must contain data that can match the chosen
meta key. For example, if the username meta key is chosen, the index column of
the csv file needs to be populated with users to be matched.
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NetWitness

Platform Feed Definition File Equivalent

Parameter

(Define Columns Identifies the column in the feed data file that provides the lookup value for the

tab, Define Index)  row. Each position in each row of the feed data file is identified by a Field

Index Column index attribute in the feed definition file. A field with an index of 1 is the first
entry in a row, the second field has an index of 2, the third field has an index of
3, and so on. You can select multiple index columns, if the Feed Type is STIX
and Index Type is Non IP. When you select multiple index columns the values
from all the selected columns are merged in the first index column that you

selected.
(DEFINE The name of the LanguageKey, as defined in the feed definition file, for which
VALUES) Key meta is created from this row of the feed data file. It corresponds to the Field

key attribute in the feed definition file. A key applies only to a field whose type
is set to value, In the feed definition file, there is a list of LanguageKeys from
index.xml, or a summary name if Source Name and Destination Name are used.
For example, reputation is a summary name for reputation.src and
reputation.dst). This value is referenced by the Field key attribute.

Creating a Custom Feed

This topic provides instructions for creating a custom feed using a .csv or STIX formatted feed data file
in RSA NetWitness Platform. For more information about STIX and creating a STIX custom feed, see
Create a STIX Custom Feed.

You can easily create a custom feed using the Custom Feed wizard. To complete this procedure, you
need a feed data file in .csvor .xm1 format. If you also have an associated feed definition file

in .xm1 format, which describes the structure of the feed data file, you can use the feed definition file to
create a feed. The Custom Feed wizard can create the feed based on a feed data file, or based on a feed
data file and corresponding feed definition file.

After completing this procedure, you will have created a custom feed.

The feed data file (. csv or STIX (.xml)) and optionally the feed definition file (. xm1) must be
available on the local file system for an on-demand custom feed. For a recurring custom feed, the files
must be available at a URL that is accessible to the NetWitness Platform server.

Note: Any feeds that are created in 11.2 release or prior will be automatically pushed to Context Hub
as Lists. The lists can be looked up in the context lookup panel of the Respond and Investigate pages.
If Context Hub is not configured or the service is down, then the feeds will be pushed to Context Hub
the next time the server is available.

To create a custom feed:
1. Goto CONFIGURE > CUSTOM FEEDS.

The Custom Feeds view is displayed.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN G’D admin = ('?l

Live Content Incident Rules Respond Notifications ESA Rules  Subscriptions Custom Feeds Log Parser Rules

Feeds

+ [

[ Name Trigger Disk Usage Created Last Run Time Status Progress

O TEST Once 2017-07-1313:30:36  Completed [e—]
| TEST2 Once 2017-07-1313:50:33  Completed O
O te Onee 2017-07-14 04:16:51 Completed C—
O onlydom Onece 2017-07-14 04:21:37  Completed C——
O PCAP Cnce 2017-07-1409:30:49  Completed ————————

2. In the toolbar, click +
The Setup Feed dialog is displayed.

Setup Feed

® Custom Feed

() Identity Feed

3. To select the feed type, click Custom Feed and Next.

The Configure a Custom Feed wizard is displayed, with the Define Feed form open.

Configure a Custom Feed

Define Feed Select Services Define Columns Review
Feed Type ® Csv () STIX
Feed Task Type @ Adhoc () Recurring
MName *
Upload As Csv |
File Feed )
File # Select File Browse
| Advanced Options
Reset Cancel Next

4. To define a feed based on a . csv formatted feed data file, select CSV in the Feed Type ficld.

5. To define an on-demand feed task that executes once, select Adhoc in the Feed Task Type field and
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do one of the following:
(Conditional) To define a feed based on a .csv formatted feed data file, type the feed Name.
Select the checkbox Upload As CSV File Feed, if required.

®

=

Select a .csv content File from the local file system, and click Next.
(Conditional) To define a feed based on an XML feed file, select Advanced Options.

&

The Advanced Options are displayed:

Configure a Custom Feed

Review

Define Feed Select Services Define Columns

Feed Type ® csv ) sTIX
Feed Task Type @ Adhoc () Recurring
Name *

Upload As Csv m
File Feed )

File * Select File Browse

() Advanced Qptions

XML Feed File | Select File Browse
Separator
Comment #
Reset Cancel Next

e. Select an XML feed file from the local file system, choose the Separator (default is comma),
and specify the Comment characters used in the feed data file (default is #), and click Next.

f. The Select Services form is displayed. This is an example of the form for a feed based on a feed
data file with no feed definition file. If you are defining a feed based on a feed definition file, the
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Define Columns tab is not needed.

Configure a Custom Feed

Define Feed

0 #  Mame ~
L o
L &
C &
L &
U s
L & .
U s
U &
C &
O .
C &
O &
Ll g
O &

Reset

Services Groups

Select Services

Address

Define Columns

Type
Decoder
Decoder
Decoder
Log Decoder
Decoder
Log Decoder
Decoder
Decoder
Decoder
Log Decoder
Log Decoder
Decoder
Decoder

Log Decoder

Cancel Prev Next

6. To define a recurring feed task that executes repeatedly at specified intervals, during a specified date

range.

a. Select Recurring in the Feed Task Type field.

The Define Feed dialog includes the fields for a recurring feed.
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Configure a Custom Feed

Define Feed Select Services Define Columns Review
Feed Type ® csv O STIX
Feed Task Type (' Adhoc ®) Recurring
Mame * TestFeed
Upload As Csv m
File Feed
URL * Verify
[[] authenticated
] Use Proxy
Recur Every < M
[] Date Range
(~) Advanced Options
XML Feed File | Select File Browse
Separator .
Comment #
Reset Cancel Next

b. Inthe URL field, enter the URL where the feed data file is located, for example,
http://<hostname>/<feeddatafile>.csv, and click Verify.

NetWitness Platform verifies the location where the file is stored, so that NetWitness Platform
can check for the latest file automatically before each recurrence.

c. (Optional) If the URL has restricted access and requires authentication using your username and
password, select Authenticated.

NetWitness Platform provides your user name and password for authentication to the URL.
d. If you want the NetWitness Platform server to access the Feed URL through a proxy, select Use
Proxy. For more information on configuring a proxy, see the Configure Proxy for NetWitness

Platform topic in the System Configuration Guide. By default, the Use Proxy checkbox is not
selected.

e. To define the interval for recurrence, do one of the following:
o Specify the number of minutes, hours, or days between recurrences of the feed.

o Specify recurrence every week, and select the days of the week.

f. To define the date range for the execution of the feed to recur, specify the Start Date and time
and the End Date and time.
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Configure a Custom Feed

Define Feed Select Services Define Columns Review
Feed Type ® Defauit O sTIX
Feed Task Type O adhoc ® Recurring
Name * TestFeed
URL* https:/fgasa2.netwitness.local/live/feeds Verify

[l Authenticated

[ use proxy

Recur Every 3 |Day(s) v

) Date Range

™) Advanced Options
XML Feed File Browse
Separator

Comment #

Reset Cancel Next

7. (Conditional) If you want to define a feed based on an XML feed file:
o Type the feed Name, select Advanced Options.
The Advanced Options fields are displayed.

o Select an XML feed file from the local file system, choose the Separator (default is comma),
specify the Comment characters used in the feed data file (default is #) and click Next.
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The Select Services dialog is displayed.

Configure a Custom Feed

[0 # Name ~
U &
L &
L &
O &
U ¢
O & .
my
O &
L &
Og&F .
L &
U ¢
O & -
O« .

Reset

Define Feed

Services Groups

Select Services

Address

Define Columns

Type
Decoder
Decoder
Decoder

Log Decoder
Decoder

Log Decoder
Decoder
Decoder
Decoder

Log Decoder
Log Decoder
Decoder
Decoder

Log Decoder

Cancel

8. To identify services on which to deploy the feed, do one of the following:

a. Select one or more Decoders and Log Decoders, and click Next.

b. Click the Groups tab and select a group. Click Next.

The Define Columns dialog is displayed.

9. To map columns in the Define Columns form:

a. Define the Index type: IP, IP Range, or Non IP, and select the index column.

Prev

MNext

b. (Conditional) If the index type is IP or IP Range and the IP address is in CIDR notation, select

CIDR.

c. (Conditional) If the index type is Non IP, additional settings are displayed. Select the service

type and Callback Keys, and optionally select the Truncate Domain option.
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Configure a Custom Feed

Define Feed Select Services Define Columns Review
Define Index
Type (0] ) IP Range ® Non IP
Index Column 1 v Service Type 0 O ¥ Truncate Domain
Callback Key(S) | Z|
0s
Define Values access.point
Column accesses [
Key action -
SRM_Saf alert
ANEsT| Alertid tpe
| alias.host |
 alias.ip
| alias.ipve
alias.mac
asn.dst
asn.src
Reset Cancel Prev Next

d. Select the language key to apply to the data in each column from the drop-down list. The meta
displayed in the drop-down list is based on the meta available for the service define values. You
can also add other meta based on advanced expertise.
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Configure a Custom Feed

Define Feed Select Services
Define Index
Type o ) IP Range
Index Column 1 = Service Type 0
Callback Key (S) action @
Define Values
Column 2
Key threat.source
SRM_SaaS_ES MXASSETInterface
AMCESTOR ASSETNUM
cent45
centds
Reset

® Non IP

™ Truncate Domain

3

v threat.category
AddChange
ASSETTAG
9164

5164

Cancel

Define Columns

Review

4

v threat.desc
EN

ASSETTYPE

Prev Next

see the Context Hub Configuration Guide.

Note: When a custom feed gets converted into a context hub list, you must map at least one

meta key with one or more meta types by mapping a column header with a meta. However, you
can add or edit the entity mapping of a list by clicking % in the Lists tab. For more information,

e. Click Next.

The Review dialog is displayed.
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Configure a Custom Feed

Define Feed Select Services Define Columns Review
Feed Details
Name Testing
C5V File AssetsimportCompleteSample.csv
Service Details
Services Log Decoder, Decoder
Column Mapping Details
ndex Type Other
Callback Key (s) action
Truncate Domain true
Service Type 0
Walue Columns
Index threat.source threat.category threat.desc
Reset Cancel Prev

10. Anytime before you click Finish, you can:
o Click Cancel to close the wizard without saving your feed definition.
o Click Reset to clear the data in the wizard.
o Click Next to display the next form (if not viewing the last form).
o Click Prev to display the previous form (if not viewing the first form)

11. Review the feed information, and if correct, click Finish.

12. Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can
expand or collapse the entry to see how many services are included, and which services were

successful.

map the entities from the List page.

Note: When you create a feed, and if there is no entity mapping done such as in case of custom meta,
then those columns in the List will not have entity mappings in Context Hub. Y ou have to manually

MetaCallback Feeds using CIDR Index Range for IPv4 and IPv6

This section describes how to use CIDR index ranges for [Pv4 and IPv6 in custom MetaCallback feeds.
As with other custom feeds, you must create feed data file in .csv format, and a feed definition file in

.xml format.

42 Additional Procedures



Live Services Management Guide

Note: Using MetaCallback feeds with CIDR index ranges is supported only through the Advanced
Configuration wizard or the REST interface.

The following example shows the contents of both a .csv file and an .xml file for a MetaCallback feed
using CIDR index ranges for IPv4 or IPvo6.

.csv file:

192.168.0.0/24, Sydney

192.168.1.0/24, Melbourne

.xml file:

<?xml version="1.0" encoding="UTF-8"?>

<FDF xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalocation="feed-definitions.xsd">

<FlatFileFeed name="ip test" path="ip test.csv" separator="," comment="#">

<MetaCallback name="DstIP" valuetype="IPv4" apptype="0"
truncdomain="false">

<Meta name="ip.dst"/>
</MetaCallback>
<LanguageKeys>
<LanguageKey name="alert" valuetype="Text" />
</LanguageKeys>
<Fields>
<Field index="1" type="index" range="cidr"/>
<Field index="2" type="value" key="alert" />
</Fields>
</FlatFileFeed>
</FDEF>

Note: To configure a CIDR index range for feeds with single or multiple MetaCallbacks of value type
IPv4 or IPv6, the field of type index MUST contain a range attribute with range="cidr". Also,
configuring "cidr" index ranges for feeds with MetaCallbacks of multiple different value types is not
supported.

Create a STIX Custom Feed

You can create a custom feed using a .csv or STIX formatted feed data file in RSA NetWitness
Platform.

Note: NetWitness Platform supports Structured Threat Information Expression (STIX) 1.0, 1.1 and 1.2
versions only.

Structured Threat Information Expression (STIX™) is a structured language for describing cyber threat
information so it can be shared, stored, and analyzed in a consistent manner. For more information about
STIX, see https://stixproject.github.io/.

Caution: If STIX recurring feed is configured and you update Security Analytics from 10.6.x to
NetWitness Platform 11.0, you must re-configure the STIX recurring feed.
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In NetWitness Platform, STIX (.xm1) feed of type Indicator or Observable which contains the
properties such as the IP addresses, File hashes, Domain names, URIs and Email addresses are
supported. The properties values in the Equals operator is only supported. And, the attributes such as
Type and Title are also read from the STIX (.xm1). The STIX (.xm1 ) with a single STIX Package is
only supported.

TAXII (Trusted Automated eXchange of Indicator Information) is the main transport mechanism for
cyber threat information represented in STIX. Using the TAXII services, organizations can share cyber
threat information in a secure and automated manner.

The STIX and TAXII communities work closely together to ensure that they continue to provide a full
stack for sharing threat intelligence.

Apart from TAXII server, STIX data can also reside on REST server and you can fetch STIX file from
the REST server by providing the URL of the REST server. For example,
http://stixrestserver.internal.com.

The feed data file (.csv or STIX (.xm1)) and optionally the feed definition file (. xm1) must be
available on the local file system for an on-demand custom feed. For a recurring custom feed, the files
must be available at a URL that is accessible to the NetWitness Platform server.

In NetWitness Platform, STIX feeds are supported. STIX content (with version 11.x) can be uploaded in
an ".xml" format. The constructs such as Indicator Title and Description, Observable Title and
Description, and Indicator Sightings information are parsed from STIX and pushed to the decoders or log
decoders that are selected during feed configuration. Information such as IP addresses, File hashes,
Domain names, URIs, and Email addresses are extracted from the STIX observable to be included in the
feed.

Make sure the following criterias are met before you upload the STIX file:
1. Only STIX Observables with property values in the "Equals" operator
2. The uploaded STIX xml file must have only one STIX Package

To create a STIX custom feed:
1. Goto Configure > Custom Feeds.

The Feeds view is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN Iilj.iladmin I:E:I

Live Content Incident Rules Respond Notifications ESA Rules  Subscriptions Custom Feeds Log Parser Rules

Name Trigger Created Last Run Time Status Progress

| FD Fetches 5TIX feeds from 2016-Feb-04 18:30, running every minute till 2071 6-Dec-30 09:01 2016-12-05 13:42:3%  2016-12-06 10:12:00  Completed [

RS /\ NETWITNESS' PLATFORM

2. In the toolbar, click +
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The Setup Feed dialog is displayed.

Setup Feed

® Custom Feed

) Identity Feed

Cancel

3. To select the feed type, click Custom Feed and Next.

The Configure a Custom Feed wizard is displayed, with the Define Feed dialog open.

Configure a Custom Feed

Select Services Define Columns Review

Feed Type sy %) ST
Feed Task Type @ Adnoc ) Recurring
Mame =
Upload As Csv
File Feed
File * Select File Browse

anviamnoed Lipdc

4. To define a feed based on a STIX formatted . xm1 file, select STIX in the Feed Type field.

5. To define an on-demand feed task that executes once, select Adhoc in the Feed Task Type ficld and
do one of the following:

a. (Conditional) To define a feed based on STIX formatted . xm1 file, type the feed Name, select a
STIX formatted .xm1 content File from the local file system, and click Next.

b. (Conditional) To define a feed based on an XML feed file, select Advanced Options.
The Advanced Options are displayed:
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Configure a Custom Feed

Define Feed Select Services Define Columns Feview

Feed Type LGV U
Feed Task Type ' Adnoc Recurring
Marme ®

Upload As Csv

File Feed '

File * Zelecr File Browse

ML Feed File | Select File Browse

Separator ~

Comment £

c. Select an XML feed file from the local file system, choose the Separator (default is comma),
and specify the Comment characters used in the feed data file (default is #), and click Next.
d. The Select Services dialog is displayed. This is an example of the form for a feed based on a

feed data file with no feed definition file. If you are defining a feed based on a feed definition
file, the Define Columns tab is not needed.

Configure a Custom Feed

Define Feed Select Services Define Columns

Services Groups

Note : 5TiX content will exist in the Context Hub service by default and you are not allowed to deselect it. Select
Decoders/Log Decoders to which STIX content must be pushed. If you do not wish to push STIX content to any
Decoders/Log decoders at this point, click Next.

O ﬁ( Name ~ Address Type

O @ Log Decoder

[ ﬁf Context Hub

O }9’ Log Decoder

O # Decoder

Reset Cancel Prev Next

6. Define a recurring feed task that executes repeatedly at specified intervals, during a specified date
range.
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a. Select Recurring in the Feed Task Type field.

The Define Feed dialog includes the fields for a recurring feed.

Configure a Custom Feed

Define Feed Select Services
Feed Type 3 ® 5TIX
Feed Task Type ' Adnoc ® Recurring
Mame < MiySTIXFeed
Upload As Csv |
File Feed
LIRL hitps//stisrestsenver.internal.com
B Trust Al Certificazes
Aurhenzicated
[ use Praxy
Tl Enabled Sereer
Recur Every -+ -
Duate Range
~, Advanced Opticns

Define Columns

Review

Verify

Cancel

b. Inthe URL field, do one of the following:

o To define a recurring feed based on STIX which pulls STIX packages from a TAXII Server,
enter the TAXII server's discovery service URL, for example, http://hailataxii.com/taxii-

discovery-service.

Note: Context Hub service installed on Event Stream Analysis host must be reachable for
the specified TAXII server.

o To define a recurring feed based on a STIX formatted .xml file using REST Server, enter the
URL of the REST server where the STIX data file is located, for example,
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http://stixrestserver.internal.com.

Configure a Custom Feed

Define Feed Select Services

Define Columns

Feed Type O Csv & STIN
Feed Task Type . Adnoc % Recuring
Mame * STI¥-server-feed

Upload As Csv O
File Feed )

URL = hetpalfstisrestserver.internal.com Werify

B Trust Al Certificares

[ Authercicated
| Use Prowy

[71 T4x1 Enailed Server

cecurtuery (18 [Rowrla ]V

Ll Dare Reange

*, Adhvanced Options

NetWitness Platform verifies the connection to the server, so that NetWitness Platform can
check for the latest file automatically before each recurrence.

If you do not want NetWitness Platform to verify the REST server's SSL certificate, Select
Trust All Certificate. This option is enabled by default (checked)

. For client authentication with the REST URL, in the Certificate field, click Browse and select

the self signed certificate. The supported certificate formats are .cer, .crt with Base64 & DER
encoded files.

(Optional) If the URL has restricted access and requires authentication using your username and
password, select Authenticated.

NetWitness Platform provides your user name and password for authentication to the URL.

Select TAXII Enabled Server, if you want to select a TAXII collection from the list.

' For a valid URL, one or more TAXII collections that contains the STIX data file is displayed

based on your credentials. Select the required TAXII collection from the list. Only one collection
can be added from a TAXII server for a feed.

Note: Though multiple feeds from multiple TAXII servers are supported, only one account
(username and password) is supported per TAXII server.

If you want the NetWitness Platform server to access the Feed URL through a proxy, select Use
Proxy. For more information on configuring a proxy, see the Configure Proxy for NetWitness
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Platform topic in the System Configuration Guide. By default, the Use Proxy checkbox is not
selected.

h. (Optional) Click Verify to test the settings.

Note: Make sure all the required connection parameters such as Authentication, Proxy, Certificate
trust, TAXII Enabled Server etc. are configured before you click Verify.

i. To define the interval of recurrence for pushing to Decoder or Log Decoder, do one of the
following:

o Specify the number of minutes, hours, or days between recurrences of the feed.

o Specify recurrence every week, and select the days of the week.

j- To define the date range for the execution of the feed to recur, specify the Start Date and time
and the End Date and time. The Start Date should be defined from when you want to fetch the
data. Make sure that the Start Date is not before 180 days from today.

7. (Optional) If you want to define a feed based on an XML feed file:
o Type the feed Name, select Advanced Options.
The Advanced Options fields are displayed.

o Select an XML feed file from the local file system, choose the Separator (default is comma),
specify the Comment characters used in the feed data file (default is #).

o Inthe Remove STIX data older than ficld, specify the number of days for which STIX packages
pulled from TAXII server is to be stored. The STIX packages older than the specified number of
days is deleted automatically.

o Click Next.
The Select Services dialog is displayed.

8. To identify services on which to deploy the feed, do one of the following:

a. Select one or more Decoders and Log Decoders, and click Next.

b. Incase of STIX feed, Context Hub will be selected by default and you are not allowed to
deselect it. In addition, you can select one or more Decoders and Log Decoders and click Next
or Click the Groups tab and select a group. Click Next.
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Configure a Custom Feed

Define Columns Review

Define Feed Select Services

services Groups

Note : 5TiX content will exist in the Context Hub service by default and you are not allowed to deselect it. Select
Decoders/Log Decoders to which 5TIX content must be pushed. If you do not wish to push 5TIX content to any
Decoders/Log decoders at this point, click Next.

O ;’5( Name ~ Address Type

O & Log Decoder

M & Context Hub

O Log Decoder

O 15( Decoder

Reset Cancel Prev Next

If the data from the STIX server is large, the following message is displayed:

Fetching sample data is taking longer than expected.
Choose one of the following options

Continue to Wait Map without Sample data

o Ifyou click Continue to Wait, it continues to wait till the sample data is fetched or timeout
(10 minutes) whichever is sooner. In case of timeout no sample data is retrieved even after 10
minutes.
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o If you click Map Without Sample data, the mapping column is displayed without any sample

data.
The Define Columns dialog is displayed.

9. To map columns in the Define Columns form:

a. Define the Index type: IP, IP Range, or Non IP, and select the index column.

b. (Optional) If the index type is IP or IP Range and the IP address is in CIDR notation, select

CIDR.

c. (Optional) If the index type is Non IP, additional settings are displayed. Select the service type
and Callback Keys, and optionally select the Truncate Domain option.

Configure a Custom Feed

Define Feed Select Services Define Columns
Define Index
Type @ p () Non IP
Index Column v [J cibr

Define Values

Column 1
Key

Observable Title

Indicator Title Indicator Description

This domain p57A5E9...  torstatus.blutmagie.de... IP:#

Domain: p5S7A5E9CF.d...

This domain p57A5E9...  torstatus.blutmagie.de...

Reset

Cancel

Review

v
Observable Description

IPvA: & Tt e -
Domain: p57A5E9CF.d...

Prev Next
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Note:

columns.

- If the Index Type is Non IP, you can select multiple index columns in the Index Column(S).
The values from all the selected columns are merged in the first index column that you selected
and the merged values are pushed to the Log Decoder for parsing. For example, in the Index
Column(S) if you select 2,4,7 as index columns the values from the 2,4 and 7 columns are
merged in the column 2 and the values are pushed to Log Decoder for parsing.

- Indexing cannot be done for the columns such as Indicator Title, Indicator Description,
Observable Title, Observable Description, as the look up cannot be performed for those

d. Select the language key to apply to the data in each column from the drop-down list. The meta
displayed in the drop-down list is based on the meta available for the service define values. You

can also add other meta based on advanced expertise.
e. Click Next.
The Review dialog is displayed.

Configure a Custom Feed

Define Feed Select Services Define Columns
Both2
http:// /taxii-discovery-service
admin.blacklisted.ip
Every 1 Minute (s)
2016-03-05T00:00:00 2016-12-05T13:45:55
CH-241, Network Decoder - Decoder, LD - Log Decoder
IP
falzse

ind.title ind.desc obs.title obs.desc Index
Reset Cancel

10. Anytime before you click Finish, you can:

Review

Prev

o Click Cancel to close the wizard without saving your feed definition.

o Click Reset to clear the data in the wizard.

Finish
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o Click Next to display the next dialog (if not viewing the last form).
o Click Prev to display the previous dialog (if not viewing the first form)
11. Review the feed information, and if correct, click Finish.

12. Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can
expand or collapse the entry to see how many services are included, and which services were

successful.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN '{:\:l:,'ladmin & (5\]

Live Content Incident Rules Respond Notifications  ESA Rules  Subscriptions  Custom Feeds  Log Parser Rules

Name Trigger Disk Usage Created Last Run Time Status Progress
DataCleanup&manths Fetches STIX feeds from 2016-Sep-12 18:30, running every 5 minutes 11 ME Completed CEEEE——

Sep-12 unning every 5 minutes Completed [

& DataCleanupimenth Fezches STIX feeds fre
Completed [}

B ABC Fetches STIX feeds from 2017-Aug-14 11:46, running every S minutes 40,36 MB

Note: Health and Wellness raises alerts when the available heap memory of Context Hub server is
critically low and the status displays as unhealthy due to low memory. For more information on how to
troubleshoot the OutOfMemoryError on the Context Hub Server, see "Troubleshooting” in the Live

Services Management Guide.

MetaCallback Feeds using CIDR Index Range for IPv4 and IPv6

This section describes how to use CIDR index ranges for IPv4 and IPv6 in custom MetaCallback feeds.
As with other custom feeds, you must create feed data file in .csv format, and a feed definition file in
.xml format.

Note: Using Metacallback feeds with CIDR index ranges is supported only through the Advanced
Configuration wizard or the REST interface.

The following example shows the contents of both a .csv file and an .xml file for a MetaCallback feed
using CIDR index ranges for IPv4 or IPvo.

.csv file:

192.168.0.0/24, Sydney
192.168.1.0/24, Melbourne

.xml file:
<?xml version="1.0" encoding="UTF-8"?>

<FDF xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalocation="feed-definitions.xsd">

<FlatFileFeed name="ip test" path="ip test.csv" separator="," comment="#">

<MetaCallback name="DstIP" valuetype="IPv4" apptype="0"
truncdomain="false">

<Meta name="ip.dst"/>
</MetaCallback>
<LanguageKeys>
<LanguageKey name="alert" valuetype="Text" />
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</LanguageKeys>
<Fields>
<Field index="1" type="index" range="cidr"/>
<Field index="2" type="value" key="alert" />
</Fields>
</FlatFileFeed>
</FDF>

Note: To configure a CIDR index range for feeds with single or multiple MetaCallbacks of value type
IPv4 or IPv6, the field of type index MUST contain a range attribute with range="cidr". Also,
configuring "cidr" index ranges for feeds with MetaCallbacks of multiple different value types is not
supported.

Creating and Managing an ldentity Feed

You can easily create an Identity feed and populate it to selected Decoders and Log Decoders. After
completing this procedure, you will have created an Identity feed.

To create an identity feed:
1. Add a destination for the feed.

a. Goto ADMIN > Services and in the Services list

b. Select a Log Collector service, and select ﬁ “'View > Config.

Select the Event Destinations tab.

d. Inthe Select Event Destinations field, select Identity Feed.

& Change Service | s Config

General Remote Collectors Files AU el a-L9 Event Destinations Settings

Select Event Identity Feed v|
Destinations

1 Log Decoder
Identity Feed |

|dentity Feed
+
e. Click and enter a unique name for the feed.

The Queue name identifies the feed within the Log Collector. Use the name of the feed for the
Queue.
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MName *

Queue

f. Click OK.

Add Identity Feed

Rollover Interval

Update Interval

Event Source Filter

Start Processor On
Service Startup

infonetd_domain

infonetd_domain

3

1

[«

Cancel

2. Test generation of messages.

a. Have users log into Windows boxes on the domain to generate the appropriate log messages on

the domain controllers for testing.

b. Verify that data is written to the feed files. SSH to the Log Decoder/Collector or Virtual Log

Collector being configured. Navigate to

/var/netwitness/logcollector/runtime/identity-feed and verify that the

Identity deploy files are getting populated with data.

[root@tps-reports identity-feed]# pwd
/var/netwitness/logcollector/runtime/identity-feed
[root@tps-reports identity-feed]# ls -lah

total 20K
drwxr-xr-x.
drwxr-xr-x.
=-M=r-=r=-,
—I'"r\ _______ .
-MW=r==r
-M-r-- 1

c. Open up a web browser (Non-Internet Explorer browsers preferred) and log in to the REST
interface of the Log Collector. Use administrative credentials when logging in. For example, if
the IP address of your Log Collector is 192.168.99.66, the URL would be:

o SSL not enabled: http://192.168.99.66:50101/event-processors

root
root
root
root
root
root

root
root
root
root
root
root

109 Nov 8 18:06 .

4 _OK Nov 12 23:14 .,

106 Nov 13 :24 identity._deploy.csv
408 Nov 13 :24 identity_deploy.feed
34 P9:06 identity_deploy.xml

. 158 3 217 identitycache.csv
Lroot@tps-reports identity-tee

o SSL enabled: https://192.168.99.66:50101/event-processors

The browser screen should look like this:
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800 Response

]

4

E] |2 [+ [0 192.168.99.66:5010/event-processors ¢ [Reader (O]
s

2 RSA T Wikiand eRoom * RSALink~™ SA ™ Personal ™

IdentityFeed (infonetd_domain) *)

LogDecoder {logdecoder) ")

The screen contains the name of the identity feed you created earlier (infonetd domain, in
this example).

For the identity feed to function correctly, port 50101 must be active on the Log Collector, and
you must determine whether SSL encryption is active.
d. Goto ADMIN > Services > <Log Collector being setup> ﬁ “ > View > Explore.

e. Inthe left pane, expand rest > config.

&+ Change Service | -Log Collector | Explore &
= [rest/config Log Collector (Log Collector)
= - Log Coll... <
allow.missing.user.agent true
= =} - Log Collector (LOG_COLLECT...
enabled 1
connections
O port 50101
event-broker
ey ssl off

Oevent-processors user.agent.whitelist

[legeollection

[logs

B rest
[Jeonfig
[ stats

[ sdk

For REST to be active, enabled must be set to 1.

f. Note the value for ssl. If SSL should be enabled for your environment, this must be set to on.

Note: If you changed the setting for either the enabled or ssl option you must restart the Log
Collector service before moving forward.

3. Go to CONFIGURE > Custom Feeds.
The Feeds dialog is displayed.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @ admin®

Live Content Incident Rules Respond Notifications ESA Rules  Subscriptions Custom Feeds Log Parser Rules

+ [
[ Name Trigger Disk Usage Created Last Run Time Status Progress

O TEST Once - 2017-07-1313:30:36 2017-07-1313:30:36  Completed C——
O TESTZ Once - 2017-07-1313:50:33  2017-07-1313:50:33  Completed e
O e Once - 2017-07-14 04:16:531  2017-07-14 04:16:51  Completed [}
O onlydom Once - 2017-07-14 04:21:37  2017-07-14 04:21:37  Completed C—
O PCAP Once - 2017-07-14 09:30:49  2017-07-14 09:30:49  Completed C—

4. In the toolbar, click +
The Setup Feed dialog is displayed.

Setup Feed

Custom Feed

® Identity Feed

Cancel

5. Make sure Identity Feed is selected and click Next.
The Configure Identity Feed panel opens with the Define Feed tab displayed.

6. (Conditional) You can create an on-demand or recurring feed.

o To define an on-demand Identity feed task that executes once, select Adhoc in the Feed Task
Type field, type the feed Name, and browse for and open the feed.

o To define a recurring Identity Feed task that executes on a recurring basis, select Recurring in
the Feed Task Type field.

The Define Feed dialog includes the fields for a recurring feed.
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Configure |dentity Feed

Define Feed Select Services Review
Feed Task Type () Adhoc (@) Recurring
Name *
URL * or name]?msg=getFile&force-content-type=application/octet-stream&expiry=600 | Verify
# Authenticated User Name admin Password eeessssses
[1 Use proxy
Recur Every 5 2 |Minute(s) w
(~) Date Range
Start Date 2015-12-14 1910025 End Date  2025-12-14 13:11:27

Cancel

Note: RSA NetWitness Platform verifies the location where the file is stored, so that
NetWitness Platform can check for the latest file automatically before each recurrence.

7. Enter a value and verify the URL field.

a. Inthe URL field, enter the URL where the feed data file is located. This is the REST API
interface that was setup earlier. Make sure you have the following information to construct the
URL:

o The IP address of the Log Collector being used to construct the Identity Feed file.
o The identity queue name, as set in step 2c.

o Whether or not SSL is enabled on the Log Collector REST port, as set in step 2f.

You can construct this value as follows:

o SSL enabled: https://<LogCollector>:50101/event-processors/<ID Event
processor name>?msg=getFile&force-content-type=application/octet-
stream&expiry=600

o SSL not enabled: http://<LogCollector>:50101/event-processors/<ID Event
processor name>?mnsg=getFile&force-content-type=application/octet-
stream&expiry=600

So, using the example from earlier, the complete value that you would enter into this field is as
follows:

http://192.168.99.66:50101/event-processors/infonetd
domain?msg=getFile&force-content-type=application/octet-
stream&expiry=600?msg=getFile&force-content-type=application/octet-
stream&expiry=600

b. For the URL verification to work correctly, it is important that the NetWitness Platform Ul
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server can access the Log Collector’s REST API port (50101). This can be tested by going to the
NetWitness Platform UI server via SSH. Once there, run the following command:

e SSL enabled: curl -vk https://<ip of log collector>:50101

o SSL not enabled: curl -v http://<ip of log collector>:50101

If the curl command does not connect then there may be a network firewall or routing issue
between the NetWitness Platform Ul server and the Log Collector.

Example of a bad connection:

About to connect() to 192.168.99.66 port 50105 (#0)
Trying 192.168.99.66... No route to host

couldn't connect to host

Closing connection #0

curl: (7) couldn't connect to host

* % % X

Example of a good connection:

About to connect () to 192.168.99.66 port 50105 (#0)

Trying 192.168.99.66... connected

Connected to 192.168.99.66 (192.168.99.66) port 50105 (#0)

GET / HTTP/1.1

User-Agent: curl/7.19.7 (x86 64-redhat-linux-gnu) libcurl/7.19.7
SS/3.19.1 Basic ECC zlib/1.2.3 1libidn/1.18 libssh2/1.4.2

Host: 192.168.99.66:50105

Accept: */*

HTTP/1.1 401 Unauthorized

Content-Length: 71

Connection: Keep-Alive

Pragma: no-cache

Expires: -1

Cache-Control: no-cache, no-store, must-revalidate
WWW-Authenticate: Basic realm="NetWitness"
Content-Type: text/xml; charset=utf-8

ANANANANANAANANAN VVVZVV £t %

<?xml version="1.0" encoding="utf-8"?>

<error>401 Unauthorized</error>

* Connection #0 to host 192.168.99.66 left intact
* Closing connection #0

8. The REST API requires a username and password when attempting to pull the identity
deploy.csv file from the Log Collector. This can be any username and password that is available
on the service itself. For more information, see the "Services Security View" topic in the Hosts and
Services Guide.

To see which accounts are available, go to ADMIN > Services > <log collector being setup>>
Actions > View > Security.

Under the Users table, you see all the users that can be used in this step. It is suggested that a
separate user account is created specifically for this setup, and is used nowhere else in the
environment, for added security. For details, see "Add a User and Assign a Role" in the System
Security and User Management Guide. (Go to the Master Table of Contents to find all NetWitness
Platform Logs & Network 11.x documents.)

9. To define the recurrence interval, do one of the following:
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10.

11.

12.

13.

14.

o Specify the number of minutes, hours, or days between recurrences of the feed.

o Enter the date range for the execution of the feed to recur, specify the Start Date and time and
the End Date and time.

If using SSL encryption, you need to install the REST API SSL certificate for the Log Collector into

the NetWitness Platform UI server. For more information, see Import the SSL Certificate.

If, after importing the SSL certificate, the verification of the URL still fails, see Cannot Verify
Identity Feed URL.

Click Verify to verify your identity feed configuration before you proceed to the Select Services
dialog.

Click Next.

The Select Services dialog is displayed.

Configure Identity Feed

Define Feed Celect Services Review
L )5( Name ~ Address Type
O & ' Decoder Decoder
] )9’ Log Decoder Log Decoder
Reset Cancel Prev Mext

To identify services on which to deploy the feed, select one or more Decoders and Log Decoders
and click Next.
Click the Groups tab, select a group, and click Next.

The Review dialog is displayed.
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Configure Identity Feed

Define Feed Select Services
ced Details
MName Testing
Feed File zip sample.zip
Service Details
Services Decoder
Reset Cancel Prev MNext

Note: If a group of devices with Decoders and Log Decoders is used to create recurring or custom
feeds and this group is deleted, you can edit the feed and add a new group to the feed.

15. Anytime before you click Finish, you can:
o Click Cancel to close the wizard without saving your feed definition.
o Click Reset to clear the data in the wizard.
o Click Next to display the next form (if not viewing the last form).
o Click Prev to display the previous form (if not viewing the first form).

16. Review the feed information, and if correct, click Finish.

Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can expand
or collapse the entry to see how many services are included, and which services were successful.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN @) admin ® | (?)

Live Content Incident Rules  Respond Notifications tom Feeds

Feeds

+
Name Trigger Disk Usage Created Last Run Time Status Progress
DataCleanup&manths Fetches STIX feeds from 2016-Sep-12 18:30, running every 5 minut Completed CEEEE——
B DataCleanupimonth Fetches STIX feeds from 2016-Sep-1 ning every 5 minutes Completed [
o ABC Fetches STIX feeds from 2017-Aug-14 11:46, running every 5 minutes Completed e
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Import the SSL Certificate

If SSL is configured on the Identity feed’s Log Collector, follow these steps to import the Log
Collector’s SSL certificate into the NetWitness Platform UI server key store. If this certificate is not
imported, the NetWitness Platform UI server will be unable to pull the Identify feed file from the Log
Collector.

1. To pull the SSL certificate off the Log Collector, SSH into the NetWitness Platform UI server and
run the following command:

echo -n | openssl s client -connect <HOST>:<PORT> | sed -ne ' /-BEGIN
CERTIFICATE-/, /-END CERTIFICATE-/p' > /tmp/<SERVERNAME>.cert

This command saves the SSL certificate to /tmp/<SERVERNAME>. cert. For example:

echo -n | openssl s client -connect 192.168.99.66:50101 | sed -ne '/-BEGIN
CERTIFICATE-/,/-END CERTIFICATE-/p' > /tmp/logcollector.cert

2. To import the SSL certificate into the NetWitness Platform UI server, SSH into the UI server and
run the following command:

keytool -importcert -alias <name an alias for the cert> -file <the cert
file pathname> -keystore /etc/pki/java/cacerts

For example:

keytool —-importcert -alias logcollector0l -file /tmp/logcollector.cert -
keystore /etc/pki/java/cacerts

3. The system requests a password. Enter the password for the keystore on the NetWitness Platform
Ul server, not for the jetty keystore. The default password is changeit.

4. Restart jettysrv to allow jetty to read the new certificate in the store.

Cannot Verify Identity Feed URL

If the Identity feed URL cannot be verified, and you are using SSL, make sure you followed the steps in
Import the SSL Certificate.

If there are issues, it is possible that the internal name of the certificate does not match the hostname of
the Log Collector. The following procedure checks this.

1. SSH to the NetWitness Platform Ul server.
2. Run the following command to output the CN name of the SSL cert:

echo -n | openssl s client -connect <log decoder>:50101 | sed -ne '/BEGIN
CERTIFICATE-/, /-END CERTIFICATE-/p'

For example:

echo -n | openssl s client -connect salogdecoder01:50101 | sed -ne ' /BEGIN
CERTIFICATE-/, /-END CERTIFICATE—/p'

3. Retrieve the CN name of the SSL certificate.
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4. Edit the /etc/hosts file and add the IP address and CN name to the file.

5. Restart the network service on the appliance.

6. Confirm that the name placed in the /etc/hosts file is used instead of the FQDN or IP address in the
Identity feed URL.

7. Re-verify the Identity feed URL.

Investigating an Identity Feed

An identity feed tracks interactive log on events from the Windows operating system. Identity feeds do
not track interactive log off events.

In order for an identity feed to process events and tag them, the events need to be collected using
a Windows Log Collection module where an Active Domain Controller or non-Domain Controller is
configured. Note that identity feeds can only be processed via an Identity Feed Event Processor.

Note: An identity feed only tracks one log in at a time. If two users log in to a system at the same
time, the second user will overwrite the first user's data in the identity feed.

Once you have created an identity feed, you can view the results by investigating the feed.

To investigate a configured identity feed:
1. Go to INVESTIGATE > Navigate.

If no default service is selected, the Investigate dialog is displayed.

Additional Procedures 63



Live Services Management Guide

Investigate

Services Collections

| Default Service

Mame ~ Address Type

Broker 10.31.125.243 Broker
Broker 10.31.125.249 Broker
Eroker 10.31.125.240 Eroker
Cancentrator (Default) 10.31.125.244 Concentrator
Decoder 10.31.125.245 Decoder

Log Decoder 10.31.125.246 Log Decoder

Cancel Navigate

2. Select a service, usually a Concentrator, and click Navigate.

3. Select Load Values to retrieve meta data.

In the Values panel, scroll down to find the Meta Keys:

RSA INVESTIGATE
NAVIGATE
= Concentrator ¥ Query © EJProfile ® EJMeta @ | B Total ® .= Descending @ B8 Event Count | SaveEvents ® - Actions ©
c
2012 | o | 15:35:00 (+00:00) All Data 2017 | 4 | 14:50:59 (+00:00)

dnyoo KeIeDy

£ Options /™ Hide

Decoder Source (2 values) L
nwappliance23912 (=100,000 - 5%) - nwappliance11639 (182)

Alerts (13 values) £

-
test dom (100,000 - 5%) - gw match (>100,000 - 38%) - ipv4 horizontal port scan 5 (6,458) - tele test (5,773) - address : 161.253.11.233 (4,948) - ip alert for 29.1 (3,581) - sky
test (3,095) - ipvd potential web sweep 10(2,280) - ipw4 vertical tcp port scan 5(2,204) - ipv4 vertical udp port scan 5(210) - ipv4 bulk data transfer 20 mb (76) - ipsrc test 176 (37)
-ipv4 bulk data transfer 50 mb (17)
_ . Risk: Informational (20 of 20+ values) L
9

http1.1 without referer header (67.513) - unknown service over http port (51.581) - unknown service over smtp port (43,798) - http1.1 without server header (39,937) - http1.0
unsupported cache header (34,360) - http1.0 unsupported connection header (32,546) - http1.0 unsupported host header (21,538) - http1.1 server location redirect (21,090) - only
ack flag in session (18,655) - unknown service over ssl port (15,679) - http1.0 without server header (12,163) - http over non-standard port (11,872) - http1.1 without accept
heaadar/11 122 _httnd 1 high hasdar caunt (10 0420 _httnd Dwithaut rafarar hasdar 7 o021y _httnd 0 uncunnartad atag haadar(c G671 _httnd 4 withaut connection

[R'S/\ NETWITNESS  PLATFORM

The identity feed provides information to selected Decoders and Log Decoders. It associates the Host IP
data from the Windows operating system to the user logging into that Host in order to tag all logs
associated with that IP and investigate.

Editing a Feed

This topic provides instructions for editing a custom feed using the Custom Feed Wizard.
After you edit a feed:
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o The feed (.zip format) or the file used to create the feed (.esv or .xml) has been downloaded and
edited.

o The feed has been recreated with the updated file and new feed specifications.

To edit an existing feed:
1. Go to CONFIGURE > CUSTOM FEEDS.
The Custom Feeds dialog is displayed.

CONFIGURE @ admin® @)

CUSTOM FEEDS

Feeds

+ |

O Mame Trigger Disk Usage Created Last Run Time Status Progress

O TEST Once Completed C—
O TEST2 Once Completed C—
O te Once Completed C—
O onlydom Once Completed C—
O PCAP Once Completed C——
O myCsY Once Completed C—

I

2. In the toolbar, select a feed and click &=.

The Configure Custom Feed or Configure Identity Feed panel opens in the Custom Feed wizard.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Feed Type 5y = ST
Feed Task Type @ Adhot ) Recwrring
Mame * TEST

Upload As Csw
File Feed

File * TECT

-t 0rm Browse
downloadfile

T S -
Advanoed LpOaons

Camcel

3. If you want to edit the feed file:
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a. Click download file.

For an Identity feed, the .zip file is downloaded. For a custom feed, the .csv or .xml file is
downloaded to your local file system.

b. Edit and save the file.
c. Inthe Define Feed tab, browse for and open the edited file.

4. Edit any other parameters in the Define Feed tab, Select Services tab, and Define Columns tab that
apply to the type of feed.

5. Anytime before you click Finish, you can:

o Click Cancel to close the wizard without saving your changes.

o Click Reset to clear the data in the wizard.

o Click Next to display the next form (if not viewing the last form).

o Click Prev to display the previous dialog (if not viewing the first form).
6. Inthe Review tab, review the feed information, and if correct, click Finish.

The feed is added to the feeds list and progress bar tracks completion. Upon successful creation of the
feed definition file, the Create Feed wizard closes, and the feed and corresponding token file is listed in

the Feeds list. You can expand or collapse the entry to see how many services are included, and which
services are successful.

Removing a Feed

This topic provides instructions for removing a feed. Y ou might want to remove a feed when some or all
of the information in the feed is no longer useful for your organization.

To remove a feed:
1. Goto CONFIGURE > CUSTOM FEEDS.

The Custom Feeds dialog is displayed.

CONFIGURE @admin© (@)

CUSTOM FEEDS

Feeds

+ |

O Name Trigger Disk Usage Created Last Run Time Status Progress

O TEST Once - 2017-07-1213:30:36  2017-07-1313:30:36  Completed C—
O TEST2 COnce - 2017-07-1313:50:33 2017-07-1313:50:32  Completed C—
O te Once Completed C—
O onlydom Once - 2017-07-1404:21:37  2017-07-14 04:21:37  Completed C—
O PCAP Once - 2017-07-14 09:30:4%  2017-07-14 09:30:48  Completed C—
O myCSY Once - 20070718 22:20112  20M17-07-18 22:24:068  Completed C—

RS /\ NETWITNESS® PLATFORM

2. In the toolbar, select a feed and click ~ .

The Delete Custom Feeds dialog is displayed.
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Delete Custom Feeds

() Local DB and Service
(® Local DB Only
(D Service Only

Cancel Delete

You can select one of the following options to delete the feed:

o If you choose to delete the feed from Local DB and Service, the feed is deleted from both
the service and the local NetWitness Platform box. The deleted feed will no longer seen on
the NetWitness Platform user interface.

« If you choose to delete the feed from Local DB Only, the feed is deleted from the local
NetWitness Platform box. The deleted feed will not be seen on the NetWitness Platform user
interface; however, the last deployed version of the feeds will be present on the service.

The undeployed feeds will be deleted forever.

o If you choose to delete the feed from Service Only, the feed is deleted from the service. The
deleted feed will appear on the NetWitness Platform user interface and can be deployed again

3. Select which feed you want to delete and click Delete.
A warning dialog is displayed.

4. Click yes to confirm that you want to delete the feed from the selected areas.

Delete Custom Feeds

Mame Service Status Progress

TEST Decoder FAILLURE o

Subscribing to Live Resources

This section describes subscriptions in Live.

Threats and the corporate landscape change over time. RSA periodically reviews existing content to
determine whether it needs to be updated based upon current campaigns, or has become irrelevant due to
changes in technology or attack techniques and tools.

You can discover new content by using the What’s New dashlet within the Default Dashboard, or by
searching through RSA Live by data range since last deployed. Be sure to subscribe to any content for
which you want to receive update notifications.
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Subscription Updates

When you view resources in the Matching Resources panel of the Live Content view, there is a column
named Updated:

no
no
no
yes
no
yes
yes
yes
no
yes
no
no
no

1

Matching Resources

Show Resuls & |

Subscribed . Name

Advenced Windows Execut..
Fingerprint Windows M5]
Microsoft Windows
windows_executable

Windows Command Shell

Lateral Movernent Indicato. ..
windows_command_shell_|...

Windows Credential Harves...

Windows Process Parent C...

Windows NTLM Network Lo._..

Autcruns and Scheduled Ta...

Windows Events (ER)

Windows Events (NIC)

66 Matching Resources

Created

20

2-02-09 £330 PV

12-02-09 457 PM
18-03-27 1:46 PM
13-10-18 1:53 PM
12-02-09 457 PM
16-03-09 12:54 AM
13-10-18 1:55 PM
18-03-09 12:34 AM
18-05-11 7:34 PM
16-03-09 12:54 AM
18-03-11 733 PM
14-02-14 3:54 &M

14-02-14 3:55 &AM

| & Package ~

20

20

uUpdated

4-03-20 353 PM

2-02-09 437 FM

18-03-27 1:47 FM
17-11-13 2:35 FM
13-08-27 7:08 AM
18-07-31 7538 FM
16-17-14 6:40 FM
18-03-09 12:534 AW
18-05-11 7:34 FM
16-03-09 12:54 AN
18-05-11 7:33 FM
18-03-27 3:30 AM

18-03-03 1211 PM

E

Type

FlexParser
FlexParser

Lag Device

Lua Parser
FlexParser
NetWitness Report
Lua Parser
MetWitness Rule
NetWitness Rule
MetWitness Rule
MetWitness Rule
Lag Device

Log Device

Description
Legacy: Intenc “
Legacy: Intenc
Log device cor
Identifies winc
Legacy: Intenc
Report display
Identifies Micr
This rule moni
There are sets
Indicates & po:
Attackers will
Log device cor
Log device cor _

3

This value is also displayed when you select the detailed view for a resource. Every time a resource
changes, its Updated value changes to match the specific update. If you are subscribed to a resource,
and it gets updated, your system is automatically updated with the latest version, and you receive a

notification. You can view your notifications by clicking the Notification icon,

the RSA NetWitness® Platform Ul.

masdl from anywhere in
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN ':E]admin = (:E]

Live Content Incident Rules Respond Notifications  ESA Rules

Subscriptions  Custom Feeds  [nerfications

service Added

Search Criterla Matching Resources wsbeen acdedtoTest 1 hour
Keywords o Resa s | | ® Package Entitlement Expiration
subscribed  Name Created updated 11 hours
Category no LDAF 20
[IFeaTURED no Kerberos 20 X
11 hours
» [ THREAT yes NWFL_accountlagon-succe 201

4 3 IDENTITY no Multiple Login Failures Due... 201

View All
Authentication na Multiple Failed Logins to Si... 2 e yoy ey g .
Authorization no VM Clone After Multiple Ro... 201 EventStream Anal...  10.4 or higher. Alert if there
Accounting no Multiple Service Connectio.. Event 5i A Detects 4 failed login acemg
» [ ASSURANCE o Remote Data Harvesting 201 201 Ev A Detects 2 successful Juniper
yes NWFL_acc n-failure 201 2014-08-1 NWFL App Rule to suppart i

» [JoperaTIONS

-and-lo... 201

207140381

NWFL App Rule ta support li

yes WV success 201 2014-08-1 NWFL App Rule to support It

yes W 20 2014-08-1 NWFL App Rule to suppart i
Resource Types _ _

no Malicious Account Crestion...  2014-0: 201 Event Stream Anal...  Dete: our

no NTLMSSP_lua 2013-09-16 3 20 Lua Parser Extra

13
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RS /\ NETWITNESS' PLATFORM

You can also get email notifications when subscribed resources are updated. System Administrators can
add email addresses in the ADMIN > SYSTEM > Live Services view. For more information, see the
"Live Services Configuration Panel" topic in the System Configuration Guide.

Adding Subscribed Resources for Deployment to Services

1. Goto CONFIGURE > Subscriptions > Deployments.

2. Inthe Groups panel, select a group.
Subscribed resources, if any, are listed in the Deployments tab Subscriptions panel.

3. Inthe Subscriptions panel, click +

The Add Subscription dialog, which lists subscriptions available for deployment, is displayed.
4. Select the subscribed resources that you want to deploy to the services group.

Click Save.

The dialog closes and the subscriptions are added to the listing in the Deployments tab, Subscriptions
panel. This stages the resources for deployment at the next synchronization.

6. You can click the Synchronize icon, B. , to immediately synchronize your changes.

Deleting a Subscription

When you delete a subscription to a resource, deployed instances of the resource are not deleted. The
deployed resource remains on services until explicitly removed, but the resource is no longer
synchronized with the resource in NetWitness Platform Live.
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To delete a subscription:
1. Go to CONFIGURE > Subscriptions.

2. Inthe Subscriptions tab, select the subscriptions you want to delete.

3. Click ~ , then choose Delete to delete your selected resources or Delete All delete all
subscriptions.

A dialog asks for confirmation that you want to delete the subscription.
4. To confirm removal, click Yes.

Your selected subscriptions are deleted from the subscriptions list, but any deployed instances of the
subscribed resource remain on the services.

Removing Subscribed Resources from the Deployments Subscriptions
Grid

Subscriptions that are selected for deployment to a service group are deployed during synchronization.
Y ou can remove subscriptions from the Live CONFIGURE > Subscriptions > Deployments panel, but
any that have actually been deployed to services remain deployed until someone removes them.

To remove resources from the Deployments tab Subscriptions panel:
1. Go to CONFIGURE > Subscriptions > Deployments.
2. In the Groups panel, select a group.

Subscribed resources, if any, are listed in the Subscriptions panel.

3. In the Subscriptions panel, click

A dialog requests confirmation that you want to delete the resource from the service group. The
resource is removed from the Deployments tab Subscriptions panel, but is not removed from services
on which it is deployed.

Subscribe and Unsubscribe to a Resource

When you subscribe to resources, you will receive notification when new versions of the resources are
available.

To subscribe to a resource:
1. Go to Live > Search view.

2. Inthe Search Criteria panel, specify search criteria and click Search.

3. Select one or more resources and click ™ Subscribe |

A confirmation dialog is displayed: By subscribing to these resources, you are indicating that you
wish to receive notification when new versions are available.

4. To confirm that you want to subscribe to the resource, click OK.

The resource is added to the subscriptions managed in the Subscriptions tab and is available for
deployment in the Deployments tab.
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When unsubscribing from a resource, you have the option to leave the resource on services on which it is
deployed or to remove it from services.

To unsubscribe from a resource:
1. Open a detailed view of a resource in one of the following ways:

o Perform a search, CONFIGURE > Live Content > enter search criteria, then select the resource
in the Matching Resources panel, then click =l Details

o View subscriptions, CONFIGURE > Subscriptions, sclect the resource from the Subscriptions
list, then click =) Details

SA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Live Content Incident Rules Respond Notifications  ESA Rules  Subscriptions Custom Feeds Log Parser Rules

}, Download 3 Unsubscribe ‘5 Deploy

Ij

= AWS Critical VM Modified Report

type NetWitness Report

2015-06-16 11:45 PM
dated 2015-06-16 11:45 PM

descriptian 10.5 and higher. Detects when Amazon Web Services (AWS) critical
virtual machine instances are modified. Actions detected by this
module include instances being terminated, stopped and rebooted as
well as modification of instance attributes and menitoring status. In
order to trigger an alert, a custom feed of critical instance source IPs
must be created to populate the alert meta key with the value
"critical_vm". Dependent on the CEF log parser.

0.1

-

RSA NETWITNESS' PLATFORM

2. With the detailed view of a resource displayed. click % Unsubscribe .

A confirmation dialog is displayed.
Unsubscribe Resource?

You will no longer be notified of new updates to this
resource.

Resource will sdll be installed unless you manually remove it

Cancel Unsubscribe Unsubscribe and Remove

3. Do one of the following:

o To confirm that you want to unsubscribe from the resource and leave it on the services where it is
deployed, click Unsubscribe.
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o To confirm that you want to unsubscribe from the resource and remove it from the services where
it is deployed, click Unsubscribe and Remove from Services.

o To close the dialog without unsubscribing, click Cancel.

The selected action is applied.

Viewing Subscribed Resources Selected to Deploy on Services

In the CONFIGURE > SUBSCRIPTIONS > Deployments tab you can view subscribed resources that
have been selected for deployment on services.

To view subscribed resources that have been selected for deployment on services:

In the Groups panel, select a group, and expand it to view services in the group. The resource
subscriptions selected for deployment are listed in the Deployments tab Subscriptions panel.

Miscellaneous Live Services Procedures

This section describes several other procedures.

Displaying Resource Details in Live Resource View

After you select a resource (in the Live Resource View), you can view its detailed information.

To open a separate tab in the Live Resource view with details of a selected resource, do one of the
following:

o If you are viewing the Detailed Results, click the resource type icon or the resource name.

RSA CONFIGURE

LIVE CONTENT

Search Criteria Matching Resources
Keywords Show Results & | | % package
malware

Ey Malware Domains

Category 3

type Feed u 17-07-19 1:02 AM version 0.869
[ FEATURED List of domains associates with malware sourced fro
» COTHREAT @ threat, malware £ threat.category, threat.desc, thre; om
» CJIDENTITY

B Malware Domain List
a type Feed upd
» T CPERATIONS List of domains

@ threat, malware P threat.category, threat.desc,

» CJASSURANCE

Resource Types

v By Malware IP List

5 Feed u 17-07-17 12:45 AM version 0.1567 size 32.05KEB 5 bed yes
M -
Medium List of ip addre: ociated with malware sourced from aredomainlist.com.
~ @ threat, malware 2 threat.category, threat.desc, threat.source g malwaredomainlist-ip

Required Meta Keys e Malware PDF

e’ KParser up 12-02-09 4:51 PM on 0.1 size 17.31 KB subscribed no

E A 'me versi 10 bove, s a par: fingerpri d Ccts P les o

Generated Mata Values - 8. For SA deployments versicn 10 and above, see lua parser fingerprint_pdf_lua Detects PDF files that contain

avascript or launch actions

m 57 Matching Resources
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o If you are viewing the list results, double-click a resource or select a resource and click Details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN [ admin ® | (3)
Live Content Incident Rules Respond Notifications ESA Rules  Subscriptions Custom Feeds
Search Criteria Matching Resources
Keywords Show Results & | Details B Deploy A Subscribe | 3 Package
malware [ | subscribed| Name Created Updated Type Description
Cartegory 4 yes Malware Domains 2012-02-09 4:48 PM 2017-07-21 1:02 AM Feed List of domains associates wi
[CIFEATURED yes Malware IP List 2017-07-20 7:21 PM Feed List of ip addresses commanly ¢
» CITHREAT no 2017-07-20 7:30 PM Feed List of domains commenly 0
» CJIDENTITY yes Legacy: Intended only fo

» [JASSURANCE Displays traffic that has been g

» ] OPERATIONS Displays DNS packet traffic that

Displays

et and log traffic ¢
Resource Types

Application Rule

Medium no FlexParser ntended only for 9.8.
v no Feed This feed contains IPs that are k
. no 2012-12-23 12:36 AM Feed This feed contains Demains tha
Required Meta Keys
no 2017-04 Application Rule The Dreambot s a banking troji

Ooooooooooood

2016-08-09 6:27 PM malicieus outbound tra

o Mirage Application Rule

Generated Meta Values ~ _ . JE - -

»
m 57 Matching Resources
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]

Downloading a Resource

You can download a single resource from the Live Resource View.

To download a resource:
1. Go to CONFIGURE > Live Content.

2. Inthe Search Criteria panel, enter the criteria needed to return the resource you want to download.
3. Select a single resource, then click =/ Details

W
4. Click Lt annlm'j.

The resource is saved as a ZIP archive to your local Downloads folder.

Locating and Removing a Deployed Resource from Services

You can locate and remove a deployed resource from services from the Live Resource View.

To view a list of services on which a resource is deployed:

1. With a resource displayed in the Resource View, click @ Service Locator

The Service Locator dialog is displayed.
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Service Locator
= Remaove
Services

O 55( MName ~
O

Type

nwappliance 192848 - Log Decoder Log Decoder

Cancel

2. Select one or more services in the Services list.

3. Click

The resource is removed from the selected services.

Showing Results as a List or in Detail

1. Select Show Results > Grid to change to grid results when viewing detailed results.

RSA RESPOND INVESTIGATE MONITOR  CONFIGURE ADMIN
Live Content Incident Rules Respond Notifications ESA Rules  Subscriptions  Custom Feeds
Search Criteria Matching Resources
Keywords Show Results @ | Details B, Deploy A Subscribe | 3§ Package
malware | subscribed| Name Created Updated Type Description
Category M yes Malware Domains 2012-02-09 4:48 PM 20170721 1:02 AM Feed List of domains associates wi
[JFEATURED [ yes Malware IP List List of ip addresses commonly :
» CITHREAT O re re Domain List
» CJIDENTITY O yes A e PDF
» CJASSURANCE O no Activity Report Displays traffic
» CJOPERATIONS O no Malware Activity DNS Displays DNS packet traffic that
O no Unidentified Displays packet and log traffic c
Resource Types
O re Vb
O re SchoolBell Ma
Medium O ne Flame Ma Detection Legacy: Intended only for 9.8. D
h O no RSA FirstWatch Command .. Feed This feed contains IPs that are k
O no RSA Fir: Command ... Feed d contains Domains tha
Required Meta Keys
O no Dreambot Malware Application Rule The Dreambot is a banking troji
O no Mirage Malware 2016-08-09 6:27 PM Application Rule Detects malicious outbound tra
Generated Meta Values A S _ R, R, N N -
4
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2. Select Show Results > Detailed to change to detailed results when viewing grid results.

RSA

LIVE CONTENT

Search Criteria

Keywords

malware

Category
[CIFEATURED

» I THREAT

» [CJIDENTITY

b [IASSURANCE

» [JORERATIONS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

CONFIGURE

Matching Resources
Show Results = |
Y Malware Domains
M Feed 2017-07-19 1:02 AM 0.869

List of domains
@ threat, malw

sociates w are sourced from v

e &£ threat.c

m

gory, threat.desc, thre

Y Malware Domain List

Feed 2017-07-17 12:40 AM

List of domains cemmeanly a:

@ threat, malware £ thre ry. threat.desc,

Ry Malware IP List

Feed 2017-07-17 12:45 AM 0.156
List of ip addresses com:

ociated with malw

gory, threat.desc,

alware PDF

Parser 2012-02-09 4:51 PM 01

ript or launch actions

57 Matching Resources

ntended only for 9.8. For SA deployments version 10 and above, see lua parser fingerprint_pdf_lua Detects PDF files that contain

@J admin & @

| 3 Package @

yes
edomains.com.

edomains.com

e [ malw

no

waredomainlist.com

ymainlist-domain

alwaredomainlist.com.

edoma

17.51 KB no
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Viewing Resource Details
You can display detailed information about a subscribed resource in the Resource View.

To view details:

1. In the Subscriptions tab, select a single subscription.

2. Click [ Details
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The details of the resource are displayed in the Resource View.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @:Jadmin O @

Live Content Incident Rules Respond Notifications ESA Rules  Subscriptions Custom Feeds Log Parser Rules

. Download 3 Subscribe |8, Deploy €D Service Locator

B Malware Domain List

Feed
2012-02-09 4:48 PM
2017-07-20 12:40 AM

List of domains commonly associated with malware sourced from
www.malwaredomainlist.com

0.1491

79.256 KB

@ threat, malware
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References

This topic is a collection of references, which describe the user interface and more detailed information
about how Live works in RSA NetWitness Platform. These topics are presented in alphabetical order.

Live Configure View

In the Live Configure view, NetWitness Platform provides integrated tools for managing Live resources.
You can manage resource subscriptions, deployments to services and discontinued resources. The
required role to access this view is Configure Live Resources. For a high-level description of how to
use the different views in NetWitness Platform Live, please read Live Services Management.

To access this view, navigate to CONFIGURE > Subscriptions. The view has three tabs:
Deployments Tab, Subscriptions Tab, and Discontinued Resources Tab.

Deployments Tab

The Deployments tab provides a user interface in the Live Configure view for:
o Viewing subscribed resources that are selected for deployment on services in a service group.
o Selecting subscribed resources to deploy to services in a service group.

« Removing resources that are selected for deployment on services in a service group.

The resources listed here are not deployed immediately after adding to a service group. Instead the
subscribed resources are pushed to the services when NetWitness Platform synchronizes with RSA
NetWitness Platform Live. The synchronization schedule is configured in the Live Configuration panel.
Additionally, you can synchronize immediately in the CONFIGURE > Subscriptions > Deployments
tab.

Likewise, resources deleted from the Deployments panel are not deleted from service where they have
been deployed. To delete resources from services, delete them in the Live Resource View.

The required permission to access this view is Manage Live Resources.

To access this view:
1. Go to CONFIGURE > Subscriptions.

The Subscriptions tab is displayed.
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2. Click the Deployments tab.

Subscriptions

Groups

Name

CONFIGURE () admin ©

RIPTIONS

Deployments [RSNGB
Subscriptions
Address Type | 8

O Name Created Updated Discontinued Type Description

RS /\ NETWITNESS' PLATFORM 11.2.0.0

The Deployments tab has two panels: Groups and Subscriptions.

Groups Panel

The Groups panel is a static display of configured service groups that were created in the Administration
Services view. Selecting a group in the Groups panel populates the Subscriptions panel with a list of
subscriptions that are selected for deployment on the services in the service group.

o omn R

Name

Address

Type

Displays the service group name. Clicking the plus sign displays a nested list of services
in the group.

Displays the IP address of each service in the group.

Displays the type of service.

Subscriptions Panel

The following table describes the features in the Subscriptions panel.

o Towmen

o

Click + to open a dialog that lists subscriptions that were added in the Live Search

view or in the Live Resource view and are available for deployment.

Click = to delete the selected subscriptions from the deployment list for service

group.
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o Jowmen

"B Click "g" to synchronize your resources to the latest versions available on Live.
Name Displays name of the resource.
Created Displays date and time that the resource was created.

Updated Displays date and time that the resource was last updated.
Type Displays type of resource.

Description Displays description of the resource.

Subscriptions Tab

Subscriptions are NetWitness Platform Live resources to which you subscribed in the Live Search view
or Live Resource view. When you subscribe to a resource, you agree to receive updates on a regular
basis from RSA NetWitness Platform Live. The choices made in the Live Configuration panel determine
the synchronization frequency and also whether you receive update notifications through email. In
addition, if you don't want to wait for the next update, you can force an immediate synchronization.

The Subscriptions tab provides a way to manage subscriptions. Each resource to which NetWitness
Platform is subscribed is listed in this tab.

In the Subscriptions tab, you can:
o View all resources to which this NetWitness Platform instance is subscribed.
o Open a detailed view of a subscription in the Live Resource View.

o Delete a subscription.

Note: Subscribing to a resource does not deploy the resource to any services. To deploy one or more
subscribed resources, go to the Deployments tab. To deploy a single resource manually, use the
Deploy option in the Resource View.

The required permission to access this view is Manage Live Resources.

To access this view, in the main menu, select CONFIGURE > Subscriptions. The Subscriptions tab is
displayed.
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CONFIGURE

RIPTIC

I GO Deployments  Discontinued Resources

- | :@:
[ Name Type Version Discontinued Updated Description
[0 [CJMalware IP List Decoder Feed 0.1567 no 2017-07-17 12:45 AM List of ip addresses commonly associated ...
O [CJIMalware Domains Decoder Feed 0.869 no 2017-07-19 1:02 AM List of domains associates with malware so...

RS /\ NETWITNESS  PLATFORM

The Subscriptions tab has a toolbar and a grid.

Toolbar

This table describes the options available in the toolbar.

Description

— i Deletes the selected subscriptions.

Details Displays the details of a single subscribed resource in the Resource View.

" _n Check the Live Server for the latest discontinued resources.

Grid

Column Description

v Selects subscribed resources to view in detail or delete. You can view details for a
single resource. You can delete one or more resources from the subscribed resources,
in effect unsubscribing,.

Name Displays name of the subscribed resource.
Type Displays type of subscribed resource.
Version Displays version of the subscribed resource.

Discontinued Indicates the status of the discontinued resources for the subscribed resource.
Yes - Resource is discontinued.
No - Resource is not discontinued.

-- - The Live Server is not checked for the discontinued resources.
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Updated Displays date and time when the subscribed resource was last updated.

Description  Displays description of the subscribed resource.

Discontinued Resources Tab

The Discontinued Resources tab provides a user interface in the Live Configure view:

o Scan the services for the discontinued resources.

« Remove the discontinued resources from any service or service group.

Note: Discontinued content still appears. With discontinued content there just won’t be any updates,
and users won’t see these items when they search in Live, unless they check the Include
Discontinued Resources box while searching.

In the RSA Content space on RSA Link, you can view the complete, up-to-date list of discontinued
resources (Discontinued Content). For each resource, there is a description of why it was discontinued.
Use these details to determine whether or not to remove a discontinued resource from your installation. .

The required permission to access this view is Manage Live Resources.

To access this view:
1. Go to CONFIGURE > Subscriptions.

The Subscriptions tab is displayed.
2. Click the Discontinued Resources tab.

The Discontinued Resources tab is displayed.

CONFIGURE

SUBSCRIPTIONS

ST Lol o VT CR T [ CHICHll  Discontinued Resources

Groups Discontinued Resources on Service
N -
MName Address Type O Name Type Version Discontinued Updated Description
458
Gl Decoder 10.31.125... Decoder

The Discontinued tab has two panels: Groups and Discontinued Resources on Service.
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Groups Panel

The Groups panel is a static display of configured service groups that were created in the Admin
Services view. Selecting a group in the Groups panel populates the Discontinued Resources panel with a
list of discontinued resources which are deployed on the selected service or service group.

e o

o Click the button to scan the services for a discontinued resource.
Displays the current status of the discontinued resources on a service.
o ; . ; ;
Note: The status of a service may change while the services are being scanned.
Name Displays service group name. Clicking the plus sign displays a nested list of services in the

group.
Address Displays IP address of each service in the group.
Type Displays type of service.

Discontinued Resources on Service Panel

The following table describes the features in the Discontinued Resources on Service panel.

Fows Jowclon

— Click the button to delete the selected resources from the service or service group.
Name This is the name of the resource.
Type This is the type of resource.
Version Version of the discontinued resource.

Discontinued Indicates the status of the discontinued resources for the subscribed resource.
Yes - The resource is discontinued.
No - The resource is not discontinued.

-- - The Live Server is not checked for the discontinued resources.
Updated Displays date and time that the resource was last updated.

Description  Displays description of the resource.

Live Feeds View

Use the Live Feeds View to:
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o Create custom feeds.
o Create identity feeds.
o Edit feeds.

The required role to access this view is Manage Devices.

To access this view, navigate to CONFIGURE > Custom Feeds.

This is an example of the Feeds view.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @ admin® | (B
Live Content Incident Rules Respond Notifications  ESA Rules  Subscriptions  Custom Feeds Log Parser Rules

Feeds

+ |

D Name Trlgger Created Last Run Time Status Progress

O FD Fetches STIX feeds from 2016-Feb-04 18:30, running every minute till 2016-Dec-30 09:01 2016-12-0513:42:39  2016-12-06 10:12:00  Completed [ —

RS /\ NETWITNESS" PLATFORM

The Feeds tab has a toolbar and a grid.

Toolbar

This table describes the options in the toolbar.

Foawrs owserpren
==

Initiates the creation of a custom or identify feed by displaying the Setup Feed dialog is
displayed.

Setup Feed

(® Custom Feed

) Identity Feed

Cancel

o Custom Feed opens the Configure a Custom Feed wizard.

o Identity Feed opens the Configure Identity Feeds wizard.

- Deletes the feed that you selected.
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o o

[# Opens the Configure Custom Feed or Configure Identity Feed wizard for the feed that you
selected (see Editing a Feed.

E Start or resume data feed.

m Stop or pause data feed.

Feeds Grid

This table describes the columns in the grid.

Selects a feed.

Name Name of the feed.

Note: You can now use special characters to define the name of the custom feed.

Trigger Displays how often the feed runs which is determined by what you defined in Feed Task
Type when the feed was created.

Created Displays date and time when the feed was created.

Disk Displays the MongoDB storage size used by the TAXII feed.
Usage

Last Run Displays date and time when the feed was last run.

Time

Status The status of the feed.

Progress  Progress bar.

Live Resource View

The Live Resource View shows a detailed view of a selected resource, and has the following options:

o Download the resource.

Subscribe or unsubscribe the resource.

o Deploy the resource to services.

o Locate services on which the resource is deployed and remove the resource from services.

The required permission to access this view is View Live Resource Details.

To access this view, do one of the following:
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1. Goto CONFIGURE > LIVE CONTENT > Search Criteria.
2. Inthe Live Search view, Detailed Results, click the resource type icon or the resource name.

3. Inthe Live Search view, Grid Results, double-click a resource or select a resource and click
Details.

This is an example of the Resource view.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @jadmin © @

Live Content Incident Rules Respond Notifications ESA Rules  Subscriptions Custom Feeds Log Parser Rules

F. Download R\ Subscribe 5] Deploy €D Service Locator

12 Malware Domain List

Feed
2012-02-09 4:48 PM
2017-07-20 12:40 AM

List of domains commonly associated with malware sourced from
www.malwaredomainlist.com

0.1491

79.256 KB

@ threat, malware

RS /\ NETWITNESS® PLATFORM

The Live Resource View has a detailed view of a single resource and a toolbar.

Resource Details

This is an example of the resource details displayed in the Resource View.
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RSA RESPOND

Live Content

INVESTIGATE MONITOR CONFIGURE ADMIN (@)admin 8

Incident Rules  Respond Notifications ESA Rules  Subscriptions  Custom Feeds

. Download R Subscribe 5, Deplay €D Service Locator

B Malware Domain List
type Feed

created 2012-02-09 4:48 PM
updated 2017-07-20 12:40 AM

description List of domains commonly associated with malware sourced from
www.malwaredomainlist.com

0.1491

size 79.256 KB

@ threat, malware

[R'S/\ NETWITNESS® PLATFORM

The following table describes the elements in the Resource Details section.

Description

Resource
Type Icon

Name
Type
Created
Updated
Description
Version in
production
Size

Required
Resources

Tagged as

L

Required
Meta Keys

A graphic representation of the resource type, for example R

The name of the resource, for example, fingerprint_office_lua,

The type of resource, for example, RSA Lua Parser,

The date the resource was created, for example, 2013-09-15 02:16 PM,
The date the resource was last updated, for example, 2013-09-15 02:16 PM

The description of the resource, for example, Identifies Microsoft Office 95, 2007 Word, Excel, and
PowerPoint documents

The version of the resource, for example, 0.1,

The size of the resource, for example, 9-079 KB,

A list of resources on which this resource depends, for example, NetWitness Lua Library. Clicking a resource
replaces the currently displayed details with the details of the one you clicked.

The tags that apply to the resource. In the example, the tags are featured, informational. Clicking a tag opens the
Live Search View with the search narrowed to match resources with that tag.

The meta keys z that apply to the resource. In the example, there are no meta keys required. Clicking a meta

key opens the Live Search View with the search narrowed to match resources with that meta key.
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o [oewen

Generates The meta values E that the resource generates. In the example, there are no meta values generated. Clicking a
Meta
Values meta value opens the Live Search View with the search narrowed to match resources with that meta value.

Permissions The permissions required for the resource.

Resource View Toolbar

This table describes the Live Resource view toolbar options.

R

Download This option downloads the resource currently displayed in the Resource View.
¥ Download

Subscribe or ; This option subscribes to or unsubscribes from the resource currently displayed in the
Unsubscribe :.‘h Subscribe Resource View.

3 Unsubscribe

Clicking Subscribe opens a dialog notifying that you are agreeing to receive
notification when the selected resources are updated. You can cancel or click OK.

e Clicking Unsubscribe asks for confirmation that you want to stop receiving
notification when the selected resources are updated. You can then choose to
cancel or you can click Unsubscribe or Unsubscribe and Remove, which also
removes the resource from services on which it is deployed.

Deploy B Deploy This option provides a way to deploy the resource currently displayed in the Resource
o View. Clicking Deploy opens the Manual Resource Deployment dialog.

Service €D Service Locator  Lhis option displays a list of services on which the currently displayed resource is
Locator deployed. You can remove the resource from all services or selected services.

Live Search View

The Live Search view provides the ability to browse the configured Live CMS for resources. Once
matching resources are found, you can view details, subscribe to resources, and deploy resources to
services and service groups.

This is an example of the Search view.
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RSA RESPOND INVESTIGATE MONITOR  CONFIGURE ADMIN @ admin©  (®
Live Content Incident Rules Respond Notifications ESA Rules  Subscriptions Custom Feeds Log Parser Rules
Search Criteria Matching Resources
Keywords Show Results = | Details B, Deploy R Subscribe | 3§ Package ©
maiware [0 subscribed Name Created Updated Type Description
Category ¥ yes Malware Domains 2012-02-09 4:48 PM 2017-07-21 1:02 AM Feed List of domains associates wi:
[CIFEATURED O yes re IP List 2017-07-207:21 PM Feed List of ip addr cemmenly :
» [JTHREAT O ne ware Domain List List of domains commanly assg
» CJIDENTITY [ yes Walware PDF Legacy: Intended only for 9.8.
b [ ASSURANCE O ro Malware Activity Report Displays traffic that has been gc
» T OPERATIONS O ne Displays DNS packet traffic that
0 ne Displays packet and log traffic ¢
Resource Types
0 ro Displays based packer and
O ne 5-10-25 6:05 PM The SchoolBell rule detects ma
Medium 0 ne Detection 05-31 8:18 PM Legacy: Intended only for 9.8. 0
v 0 ne Watch Command ... This feed cantains IPs that are k
O ne RSA FirstWarch Command ... 2017-07-20 7:20 PM Feed This feed contains Domains tha
Required Meta Keys
O ne Dreambot Malware 2017-04-04 7:36 PM Application Rule The Dreambot is a banking troji
O no Mirage Malware Application Rule Detects malicious outbound tra
Generated Mata Values . _ X . R . . _ ~ X -
»
m 57 Matching Resources

RS /\ NETWITNESS® PLATFORM

The Live Search view has a panel for specifying search criteria and a panel that displays matching
resources. The Search Criteria panel is collapsible to provide more width for viewing the Matching
Resources panel.

Search Criteria Panel

This is an example of the Search Criteria panel.

Search Criteria

Keywords

[CIFEATURED
» [ THREAT
» CTIDENTITY
» CIASSURANCE
» CIOPERATIONS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Modified Date: A

The following table provides descriptions of the Search Criteria panel features.
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o w2

Keyword(s)

Category

Resource Types

Medium

Tags

Enter a keyword or keywords to browse for resources that have the keyword in the resource name or the
resource description. You can use wildcards when you enter a keyword.

The categories mirror the hierarchical Investigation Model that RSA uses to organize resources. The
purpose of the Investigation model is to deliver an accurate path to information security incident response.
For more information, see the Investigation Model topic in the RSA Content space on

RSA Link.

Select resources types from the drop-down list to filter resources by type of resource. Possible values are:

Advanced Analytics (Warehouse)
Application Rule

Bundle

Correlation Rule

Event Stream Analysis Rule
Feed

FlexParser

Log Collector

Log Device

Lua Parser

Malware Rules

NetWitness List
NetWitness Report
NetWitness Rule

Note: Some rules that have been deployed to an earlier version of RSA NetWitness® Platform may not
deploy or execute on NetWitness 11.x. For more information, see the Troubleshooting Live
Services.

Select one or more mediums from the drop-down list to search for content based on the meta data source.

Available values for medium are as follows:

endpoint: for NetWitness Platform 11.3 and later): applied to content that uses
meta derived from endpoint agent and endpoint server data

log: applied to content that uses meta derived from log data
packet: applied to content that uses meta derived from network packets

log and packet: applied to content that correlates meta derived across log and
packet data

Select meta tags from the drop-down list to browse based on how the meta is tagged. For example, to
browse resources for a Log Decoder, select the netwitness for logs tag. Alternatively, you can click a tag
in the Matching Resources panel to insert that tag in this field.
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o owain

Required Meta Enter a specific meta key; for example, threat.source, Alternatively, you can click a meta key in the
Key(s) Matching Resources panel to insert that tag in this field.

Generated Meta Enter a generated meta value; for example, netwitness. Alternatively, you can click a generated meta key in
Value(s) the Matching Resources panel to insert that tag in this field.

Research Created  Specify a date range during which resources were created. For example, to browse resources that were
Date created between January 1 and January 4, you select January 1 as the start date and January 4 as the end
date. You must enter dates in mm/dd/yyyy format or you click and pick dates from a calendar.

Research Modified  Specify a date range during which resources were modified. For example, to browse resources that were
Date modified between January 1 and January 4, you select January 1 as the start date and January 4 as the end
date. You must enter dates in mm/dd/yyyy format or you click and pick dates from a calendar.

Search Click Search to send the search request to the Live server. More specific search criteria return matching
resources more quickly.

Cancel Click Cancel to cancel the search in progress.

Include Check Include Discontinued Resources to include the discontinued resources in the search result. For an
Discontinued up-to-date list of resources that have been discontinued, see the Discontinued Content topic.
Resources

Matching Resources Panel

The Matching Resources panel displays search results based on the selections made in the Search
Criteria panel. Results are initially displayed in a grid, but you can switch between two Show Results
options: Detailed or Grid.

Detailed Results

In the detailed results, you can click a tag, meta key, or resource meta value to auto fill the Search
Criteria panel and pivot the search results.

The following table describes the elements in the detailed results.

o ovn

Resource Type A graphic representation of the resource type. For example F -
Icon

Name The name of the resource, for example, Group Management.

Note: (Discontinued) is displayed next to the resource name if a resource is discontinued.

Type The type of the resource, for example, Rule,

Updated The date when the resource was last updated, for example, 2015-09-15 4:27 PM,
Version The version of the resource, for example, 0.1,

Size The size of the resource, for example, 153 B,
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o o

Subscribed

Description

Tags

Meta Keys

Resource Meta
Values

Subscription status:
o yes: This NetWitness Platform instance is subscribed to this content resource.

o no: This NetWitness Platform instance has not subscribed to this content resource.

The description of the resource, for example, Compliance Rule-Group Management,

The tags that apply to the resource. Clicking a tag narrows the search to resources with that tag. For example,

The meta keys that apply to the resource. Clicking a meta key narrows the search to resources with that meta
key. For example, f

The meta values generated by the resource. Clicking a meta value narrows the search to resources that

generated the meta value. For example, E 5

Grid Results

In the grid view, you can select one or more resources and use additional options in the toolbar to view
the details of a single resource, subscribe to resources, and deploy resources.

The following table describes the elements in the grid results.

o T

Subscribed Subscription status:
o yes: This NetWitness Platform instance is subscribed to this content resource.
e no: This NetWitness Platform instance has not subscribed to this content resource.
Name The name of the resource, for example, Group Management.
Note: The resource name is displayed in red color if it is discontinued.
Created The date when the resource was created, for example, 2015-08-12 3:11 PM,
Updated The date when the resource was last updated, for example, 2015-09-15 4:27 PM,
Type The type of the resource, for example, Rule,
Discontinued The status of the discontinued resources:
o yes: The resource that matches the search criteria is discontinued
e no: The resource is not discontinued
e --: The Live Server is not checked for the discontinued resources
Description The description of the resource, for example, Compliance Rule-Group Management.
Toolbar
References 91



Live Services Management Guide

o [

Show Re This menu offers two ways to view search results: Detailed and Grid.

Detzils  This option applies to a single selected resource. Clicking Details opens the selected resource in the Live
Resource view.

:EJ: Deploy  This option applies to one or more selected resources.

3 Subscrib This option applies to one or more selected resources. Clicking Subscribe opens a dialog that asks for
confirmation that you want to receive notification when the selected resources are updated.

x Package This menu offers two packaging functions for the selected resources:

o Create: creates a resourceBundle.zip file that contains the selected resources and opens a dialog in which
you can either:

e open the file, or
o save the file for subsequent deployment.

o Deploy: opens the Deployment Wizard, in which you can choose a resourceBundle.zip file and deploy it.

See Also

« For more information on Deployment (:E": Deploy) see Find and Deploy Live Resources.

o For more information on Deploying a Package (;t Package ), see the Resource Package
Deployment Wizard,.

Live Search Content View

The Live Search Content view provides the ability to search the configured Live CMS for contents.
Once matching contents are found, you can view the details, and download the contents.

This is an example of the Search Content view.
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&) Content
Content View Featured, new and recently upd

Featured

Showing Featured Content (39) Timezone : GMT+0530 Asia/Calcutta
O New

O Recently Updated NAME & CREATED 3 UPDATED 4 TYPE 4 DESCRIPTION 4
28-May-2019 22:49:42 28-May-2019 22:50:59 Lua Parser Identifies possible Electricfish tunneling sessions. DEPENDENCIES Feeds *in...
Search Content .. 27-Feb-201720:37:36 23-5ep-2017 11:11:37 NetWitness Report This report summarizes all RSA SecurlD Authentications. An incident respons...
23-Dec-2012 06:06:00 24-Nov-2020 08:31:05 Feed This feed contains Ps that are known to be associated with malware comman...
23-Dec-201206:06:04 23-Nov-202009:31:28 Feed This feed contains Domains that are known to be associated with malware co,
14-Mar-2017 20:51:12 23-Sep-2017 11:11:27 NetWitness Report Displays traffic that has been going to a known malicious IP address o refere...
16-May-2012 06:37:42 24-Nov-2020 03:35:30 Feed This feed contains domains known to be associated with APTs.
12-5ep-2013 19:55:28 18-Jul-2020 01:25: Lua Parser Extracts submitted values from HTTP POST actions. Supports: - application/x...
15-Nov-2013 18:12:58 27-Oct-202001:45:08 Lua Parser Extracts values from HTTP protocol request and response headers. Parses IC...
28-5ep-2016 01:41:00 -2 06 Event Stream Analysis Rule  For Cerber4 to Cerber6, the rule looks for a spray of outbound suspected com...
04-May-2017 01:47:09 -Jul- :01:19 Event Stream Analysis Rule  Identifies mail sessions that have a punycode hostname and also have a misma..
18-Oct-201319:23:37 25-Feb-2019 21:04:48 Lua Parser Identifies Microsoft SQL Server ‘Tabular Data Stream’ protocol. Registers clie...
18-Oct-201319:23:48 22-May-2019 20:46:55 Lua Parser Identifies the Microsoft Remote Desktop Protocol. RDPis encrypted by defa...
16-May-2012 06:37:45 24-Nov-202003:40:31 Feed This feed contains IPs known to be associated with APTs.
01-May-2017 20:04:47 23-5ep-2017 11:08:03 Lua Parser Detects SuperCMD Trojan beaconing. DEPENDENCIES None CONFLICTS N...
01-May-2017 20:04:45 23-5ep-2017 11:07:36 Lua Parser Detects punycode-encoded internationalized domain names which use non-L...
16-Sep-2013 08:36:20 18-Nov-2020 01:26:05 Lua Parser Extracts action and authentication from Microsoft's DCERPC protocol. DEPE...

13-Feb-20140: :! 17-Jul-; 07:: Feed Contains IPs published as malicious from third party research and publications.

The Live Search Content view has a panel for specifying search content and displays the matching
contents on the right panel.

Search Content Panel

This is an example of the Search Content panel.
Search Content

KEYWORDS
RESOURCE TYPES

TAGS
featured x

REQUIRED META KEYS
GENERATED META VALUES

CREATED DATE

Startda.. — Enddate B

MODIFIED DATE

Startda.. — Enddate B

[ Include Discontinued

Search Reset Filter

The following table provides descriptions of the Search Content panel features.

Description

Keywords Enter a keyword or keywords to browse for contents that have the keyword in the
resource name or the resource description. You can use wildcards when you enter a
keyword.
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o o

Resource
Types

Tags

Required
Meta Keys

Generated
Meta Values

Created
Date

Modified
Date

Select resources types from the drop-down list to filter resources by type of resource.
Possible values are:

o Application Rule

o Feed

e Log Device

o Correlation Rule

o NetWitness Rule

o NetWitness Report

o Lua Parser

o Log Collector

o NetWitness List

o Malware Rules

o Event Stream Analysis Rule

o Advanced Analytics (Warehouse)
o Bundle

o Health and Wellness Dashboards
o Health and Wellness Monitors

« Investigate Profile

o Investigate Column Group

o Investigate Meta Group

Select meta tags from the drop-down list to browse based on how the meta is tagged.
For example, to browse contents for a Log Decoder, select the netwitness for logs
tag.

Enter a specific meta key. For example, threat.source,

Enter a generated meta value. For example, rsa-firstwatch.

Specify a date range during which contents were created. For example, to browse
contents that were created between January 1 and January 4, you select January 1 as
the start date and January 4 as the end date. You must enter dates in yyyy/mm/dd
format or you click B and pick dates from a calendar.

Specify a date range during which contents were modified. For example, to browse
contents that were modified between January 1 and January 4, you select January 1 as
the start date and January 4 as the end date. You must enter dates in yyyy/mm/dd
format or you click Bl and pick dates from a calendar.
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Description

Search Click Search to send the search request to the Live server. More specific search
criteria return matching contents more quickly.

Reset Filter  Click Reset Filter to reset the existing search results and displays all the content on
the right panel.

Include Check Include Discontinued to include the discontinued contents in the search result.
Discontinued For an up-to-date list of contents that have been discontinued, see the Discontinued
Content topic.

Search Results Panel

The Search Results panel displays search results based on the selections made in the Search Content
panel.

This is an example of the Search Results panel.

7 Content

View Featured, new and recently updated content details here.

Showing Filtered Content (330) Timezone : GMT+0530 Asia/Calcutta

NAME §

CREATED 4
16-May-2012 06:37:45
09-Feb-2012 22:18:20
09-Feb-2012 22:09:55
09-Feb-2012 22:10:05
13-Feb-201403:19:25
24-)Jul-2012 10:54:16
09-Feb-2012 22:18:00
09-Feb-2012 22:18:19
13-Feb-2014 04:43:33

09-Feb-201222:11:47

UPDATED § DESCRIPTION §

24-Nov-2020 03:40:31

11-Apr-2017 14:47:05

15-Apr-2016 08:02:55
17-Jul-2019 06:30:06

24-Nov-2020 05:50:28
15-Apr-2016 08:02:54
24-Nov-202003:30:31

17-Jul-2019 07:30:05

15-Apr-2016 08:03:30

This feed contains IPs known to be associated with APTs. I
This feed contains ips that represent known VPN exit nodes for criminal anon...
AlertlD to name mappings for informational alerts

This feed identifies many commonly seen dynamic dns related domains

Contains domains published as malicious from third party research and public...
DROP (Don't Route Or Peer) and EDROP are advisory "drop all traffic” lists, c...
Alerts on extensions as follows: doc,xIs,ppt,pdf,txt,xml

This feed contains ips that represent known VPN entry nodes for criminal ano...
Contains IPs published as malicious from third party research and publications.

whitelist domains for spectrum

The following table describes the elements in the search results panel.

Description

Name The name of the content. For example, Log Parser Pack.

Created The date when the content was created. For example, 04-Aug-2017 15:19:06.

Updated The date when the content was last updated. For example, 29-Sep-2020 20:27:14.

Type The type of the content. For example, Bundle,

Description  The description of the content. For example, Contains all parser files and log
collection files.

Discontinued The status of the discontinued content:

o Yes: The content that matches the search criteria is discontinued

o No: The content is not discontinued

References
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Content Details Panel

In the Search Results panel, you can select any content titles to view the details in the pop-up window
and download the contents.

This is an example of the Content Details panel.

Content Details

Log Parser Pack

TYPE
Bundle

CREATED
04-Aug-2017 15:19:06

UPDATED

29-Sep-2020 20:27:14

DESCRIPTION
This pack contains all parser files and log collection files. See the dependencies for a full list of bundled
content.

VERSION ON PRODUCTION
0.5

SIZE
14.96 KB

REQUIRED RESOURCES

@ Large files may take longer time to start the download. Close Download

The following table describes the elements in the Content Details section.

e

Name The name of the content. For example, Log Parser Pack.

Type The type of the content. For example, Bundle,

Created The date when the content was created. For example, 04-Aug-2017 15:19:06,
Updated The date when the content was last updated. For example, 29-Sep-2020 20:27:14.

Description  The description of the content. For example, Contains all parser files and log
collection files.

Version on The version of the content. For example, 0.5.
Production

Size The size of the content. For example, 14.96 KB.
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Required A list of resources on which this resource depends. For example, NetWitness Lua
Resources Library. Clicking a resource replaces the currently displayed details with the details
of the one you clicked in the pop-up window.

Tags The tags that apply to the content. For example, threat. Clicking a tag opens the Live
Search Content view with the search narrowed to match contents with that tag.

Required The meta keys that apply to the content. For example, Threat Category. Clicking a
Meta Keys meta key opens the Live Search Content view with the search narrowed to match
contents with that meta key.

Generated The meta values that the content generates. For example, rsa-firstwatch. Clicking a
Meta Values meta value opens the Live Search Content view with the search narrowed to match
contents with that meta value.

Discontinued The status of the discontinued content:
o Yes: The content that matches the search criteria is discontinued

o No: The content is not discontinued
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Resource Package Deployment Wizard

If you have created a package of resources and saved it on a network drive, you can use the Resource
Package Deployment Wizard to deploy the resources manually to a service or a service group without
subscribing to the resources. NetWitness Platform accepts packages in .nwp files or .zip files.

Deploying resources manually deploys them directly to the services without taking advantage of the
powerful resource management capabilities of NetWitness Platform.

If you want to receive notification and updates for updated resources and be able to easily remove
resources from a service, you must subscribe to resources in the Live Search view and deploy the
resources in the Live Configure view.

Note: Use NetWitness Platform Live to create resource bundles; this is a different application that is
not part of NetWitness Platform. Selecting Package > Create in the Live Search - Matching
Resources toolbar displays the Content Package Tool window. You can choose resources to include in
a package and save the package as a NetWitness Platform Package File.

The required permission to access this view is Deploy Live Resources.
To access this view:
1. Go to CONFIGURE > Live Content.

A Package ~

2. Inthe Live Search - Matching Resources toolbar, select > Deploy.

The Resource Package Deployment wizard is displayed.

Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle Browse

Cancel Mext
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Features

The Deployment Wizard has five tabs: Package, Resources, Services, Review and Deploy.
Use Close to exit before you complete the wizard.

When you complete the wizard, NetWitness Platform returns to the Live Resources View.

Package Tab

You use this tab to select a resource bundle from your network in this page.

This is an example of the Package tab, with a resource bundle already selected.

Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle resourceBundle3866217298122437775.zip Browse

Cancel

The following table describes the elements in the Package tab.

Resource Bundle  The input field to specify a resource bundle. You can type a path in this field or search using the

S button.
Command Buttons
Browse This button opens a File Upload dialog in which you can browse the local file system and select a bundle.
Cancel Cancels the deployment and closes the wizard.
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Next Displays the next tab of the wizard.

Resources Tab

This tab displays the resources contained in the bundle.

The following figure shows an example of the Resources tab.

Resource Package Deployment

Package Resources Services Review Deploy

Total resources : 2

Resource Names Resource Type Dependency Of
suspicious php put long query R5A Application Rule
APT Domain Intelligence R5A Application Rule

Cancel

The following table describes elements in the Resources tab.

Resource Name Displays the name of the resources in the bundle (for example, NetWitness Lua Library),
Resource Type Displays the resource types for the resources in the bundle (for example, RSA Lua Parser)
Dependency Of Displays Resources on which the selected resource depends (for example, AIM lua),

Services Tab

You select the services on which you want to deploy the resources in the bundle.

The Services tab has two tabs, Services and Groups. These provide a list of services and service groups
that are configured in the ADMIN > Services view. The columns are a subset of the columns available
in the Services view. You can select the services or the service groups on which you want to deploy the
resources in the bundle.

This is an example of the Services tab.
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Resource Package Deployment

Package Resources Services Review Deploy

Services Groups

O / Name ~ Type

Decoder
Decoder
Decoder

Log Decoder

0

Decoder

Log Decoder

|

Decoder
Decoder
Decoder
Log Decoder

Log Decoder

O
™MW R RN RN WA

Decoder

Cancel Previous

The following table describes the elements in the Services tab.

Services
I:l Selects services on which you want to deploy the content. You can select any combination of services and service
groups.
Name Displays the services in your environment on which you can deploy the content.
Host Displays the name of the resource host.
Type Displays the type of NetWitness Platform service.
Groups
I:l Selects service groups (if you have service groups defined in your environment).
Name Displays the names of the service groups.

Review Tab

Displays the resources and services on which the resources will be deployed.

In this tab, you can do the following:
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o Review the content and services before you deploy.

o Initiate the deployment of the resources.

The following figure shows an example of the Review tab.

Resource Package Deployment

Package Resources Services Review Deploy
Service Service Type Resource Mame Resource Type
Decoder suspicious php put long query R5A Application Rule
APT Domain Intelligence R5A Application Rule
Cancel Previous Deploy

The following table describes the elements in the Review tab.

Service Information
Service Displays the services in your environment on which you can deploy the content.
Service Type Displays the type of each NetWitness Platform service (type of host or service).
Resource Information

Resource Name  Displays the name of the resources you have selected (for example, NetWitness Lua Library),

Resource Type Displays the resource types for the resources you have selected (for example, RSA Lua Parser),
Deploy Initiates the deployment of the resources and displays the Deploy page (final page of the wizard).
Deploy Tab

This tab allows you to do the following:
o View the progress of the job
o Cancel the job

This is an example of the Deploy tab.
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Resource Package Deployment

Package Resources Services Review
Service Name Resource Mame Status Progress
Oof2 A

Cancel

The following table describes the elements in the Deploy tab.

o owmen

Service Name of the services to which resources are deployed.

Name

Resource Name of the resources.

Name

Status Status of the manual deployment.

Progress Progress of the manual deployment in a progress bar. When complete, the bar turns solid green.

Command Buttons

Close Closes the wizard.
Errors Only displays if NetWitness Platform encountered any errors. Click to display the errors.
Retry Only displays if NetWitness Platform encountered any errors. Click this button to try to deploy the resources

again using the wizard.

RSA Live Registration Portal

The RSA Live Registration Portal is a self-service wizard in which customers can set up a Live account
and change or reset the password. A Live account is required to get access to the feeds, parsers, rules,
and other content in RSA Live library. To access the portal, go to the following

URL: https://cms.netwitness.com/registration/.
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Welcome to RSA Live Registration Portal

Thank you for using RSA NetWitness.
Please sign up here for your RSA Live account to access your subscription content.

End User License Agreement

THIS SOFTWARE CONTAINS COMPUTER PROGRAMS AND OTHER PROPRIETARY
MATERIAL AND INFORMATION, THE USE OF WHICH IS SUBJECT TO AND EXPRESSLY
CONDITIONED UPON ACCEPTANCE OF THIS END USER LICENSE AGREEMENT (THE
“AGREEMENT” OR “CSA").

THIS AGREEMENT IS A LEGALLY BINDING DOCUMENT BETWEEN YOU (MEANING THE
INDIVIDUAL PERSON OR THE ENTITY THAT THE INDIVIDUAL REPRESENTS THAT HAS
OBTAINED THE SOFTWARE AND HARDWARE FOR ITS INTERNAL PRODUCTIVE USE AND
NOT FOR OUTRIGHT RESALE) (THE “CUSTOMER”) AND RSA (WHICH MEANS (I) IF

RSA
NETWITNESS'

PLATFORM LIVE

Sign Up for RSA Live Account @

First Name

Last Name

Company

License ID

CUSTOMER IS LOCATED IN THE UNITED STATES, MEXICO OR SOUTH AMERICA, THEN
THIS IS A LEGAL AGREEMENT BETWEEN THE CUSTOMER AND RSA WITH “RSA"

MEANING RSA SECURITY

Username

LLC. IF CUSTOMER IS LOCATED OUTSIDE OF THE UNITED

ACCEPT

Password

CREATE ACCOUNT

Click Sign Up For Live. The License Agreement page is displayed, once you agree to the Terms and
Conditions, click Accept: the fields for setting up an account are displayed. These include Contact
Information, and License ID.

The following table lists the contact information section fields and its descriptions:

Parameter | Description

First Name

Y our first name.

Last Name Y our last name.
Company The name of your company.
Email The email address where you want to receive notifications related to the Live account.
License ID This is the License Id on the Admin > System > Info page.
Caution: The license ID on the NetWitness Platform must be valid and must be registered on the Flexera
Server. If not, contact RSA Customer Support.
Username The username used to sign in to RSA Live account. The username must contain a minimum of nine characters
and a maximum of 60 characters.
Password The password for the RSA Live account. The password must contain minimum of nine characters and the
maximum length is 60, with at least one uppercase, one lowercase, one number, and one special character.
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NetWitness Platform Feedback and Data Sharing

The Live Feedback Activity Log enables you to download the usage data required for Live Feedback.
After you download the Live Feedback data, you can then upload it to share with RSA.

The settings for these features are available in ADMIN > System > Live Services view,

in the Additional Live Services section.

Additional Live Services

Participation in the Additional Live Services is configured in the ADMIN > SYSTEM > Live Services
view.

Live Feedback

Live Feedback is intended to help improve RSA NetWitness Platform.

Additional Live Services
Live Feedback

RS54 collects details about the services you use in your deployment for new features and other improvements to the
platform. Informaticn collected is securely sent to RSA.

[ Additional Feedback Insights

Send additional information to improve feature usage. Learn maore.

Once you set up and configure a Live account, usage data is automatically shared with RSA and is
protected in accordance with the applicable license agreement. All such data shall be anonymized and
shall not have any Personally Identifiable Information.

Before data is sent to RSA, all Personally Identifiable Information is removed. Thus, only anonymous
usage data gets transferred to RSA.

For more information, see the "Live Feedback Overview" topic in the System Configuration Guide.

RSA Live Connect

RSA Live Connect is a cloud based threat intelligence service. This service collects, analyzes, and
assesses threat intelligence data such as IP addresses, domains, and files collected from various sources
including the RSA NetWitness Platform and RSA NetWitness Endpoint customer community.
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RSA Live Connect (Beta)

R5A Live Connect is a cloud based threat intelligence service, This service collects, analyzes, and assesses threat
intelligence data such as IP addresses, domains, and files collected from varicus sources including the RSA
MetWitness Suite and RSA NetWitness Endpoint customer community. The R5A Live Connect dloud service stores
this infarmation in a secure environment and provides an anonymous, secure 2-way channel over 551 between the
RSA Live Connect cloud and the RSA NetWitness Suite/RSA NetWitness Endpoint customers to share and monitor
de-identified and obfuscated threat intelligence. This threat intelligence information can be leveraged by analysts for
identifying and investigating potential security threats, Learn mares.

M Enable Threat Insights @® Connected

This Live Connect option provides analysts the opportunity to pull threat intelligence data such as IP
related information from the Live Connect service to be leveraged by analysts during investigation. In
addition, analysts can wvoluntarily provide ancnymous risk assessment feedback on the specific
intzlligence to Live Connect,

™ Enable Analyst Behaviors ® Connected

This Live Cannect aption is an automated data collection service. It is responsible for gathering meta
data captured locally by MetWitness Suite and securely sending it to RSA Live Connect.This data will be
leveraged for deep analysis to drive and improve the RSA Live and Live Connect threat intelligence
services in order to proactively identify potential security threats.

NOTE: The type of data that potentially could be shared from a user’s network to the RSA Live Connect
cloud service could encompass various types of meta data captured by the NetWitness Suite product
such as jp.sre, ip.dst, ip.addr, device.ip, alias.ip, alias.host, paddr, sessionid, domain.dst, domain.sre.

Customers who do not wish o receive threat intelligence and/or share de-identified and anonymized information
with the Live Connect service should change their settings in the Live Connect feature and/or contact R5A Customer
Support for more information.

RSA Live Connect consists of the following features:
o Threat Insights

o Analyst Behaviors

Threat Insights

Threat Insights provides analysts the opportunity to pull threat intelligence data such as IP related
information from the Live Connect service to be leveraged by the analysts during investigation.

By default, Threat Insights is enabled in Additional Live Services section. If Context Hub service is
configured, Live Connect is automatically added as a data source for Context Hub. For more
information, see the "Configure Live Connect Data Source for Context Hub" topic in the Context Hub
Configuration Guide.

With Live Connect as a data source for context hub, you can use the Context Lookup option in
INVESTIGATE > Navigate view or INVESTIGATE > Events view to fetch contextual information.
For more information, see the "Look Up Additional Context in the Navigate and Events Views" topic in
the Investigate User Guide.
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Analyst Behaviors

Analyst Behaviors is a feature where analysts participate in sharing data to RSA community. This is an
automated data collection service. Its goal is to share potential threat intelligence data to the RSA Live
Connect cloud service for analysis. The type of data that could be shared from your network to RSA
Live Connect includes various types of meta data captured by NetWitness Platform such as ip.src, ip.dst,
ip.addr, device.ip, alias.ip, alias.host, paddr, sessionid, domain.dst, domain.src.

Note: All data collected locally is de-identified and obfuscated and then sent securely and
anonymously to the RSA Live Connect cloud service, where it is stored in a secure environment.

Description

Live Connect Threat Data Sharing has been developed as a Community based threat intelligence sharing
platform.

SA Community Live Connect

e hetpods

Cuslomer & 3 4 °
ST T T e >
— Ihttp:f_{ 9

Customer B | [— t_. _________________ >

Http:a’i ° - >

b DAL Ly

Customer G .\_: -

It has the following characteristics and goals:
o Crowd-sourced: the RSA community contributes to the entire collection of intelligence
o Centrally collect and analyze data from the RSA community

o Reduce the intelligence cycle time from days to minutes

Some details to consider:

o We are leveraging analyst investigation activity

o We are harvesting meta data such as IP addresses and domain names

o We are doing deep data analysis: Trending, correlation, anomaly detection

o Remember, this feature is currently in Beta
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File Reputation

File Reputation service provides instant access to the latest signatures via the RSA Live feed so data is
more relevant, with fewer false positives. With this service, users always have reliable data about the
reputation of files in their NetWitness Endpoint system. In addition to the whitelisting service, it provides
blacklisting information as well.

File Reputation

¥ Enable File Reputation _) Not Cannected

This opticn is used to view reputation status of files. The File Hash information from NetWitness Platform is sent to
RS54 Live to get the reputation status. Reputation status is leveraged by analysts during investigation of files.Learn

maore.

Participation in RSA Live Connect

On install or upgrade to NetWitness Platform 11.x, a confirmation screen is displayed. You are
presented with a New Features Enabled dialog box, where you can enable or disable Threat Insights
and Analyst Behaviors.

Cloud Authentication

Authentication for the program is done in the NetWitness Platform Ul, where you configure the Live
account in the Live services section.

Configuration

To view or change the settings for Live Connect Threat Data Sharing, select ADMIN > System > Live
Services. Check or clear the Enable box to participate or stop participating in the program.

Data Collection
Data is collected as follows:
o Data Attribution: Anonymous

o Data Source: Subset of meta keys and meta values of a NetWitness Platform analyst's page views
from the NetWitness Platform Core Query logs.

o Query Log Harvesting Process:
o Timing: Batch mode every 24 hours (4 AM — 6 AM UTC)

o Log Collection: NetWitness Platform server collects NetWitness Platform core device log entries
for the previous 24 hours

o Log Entries: Only SDK-Value and SDK-Query API calls that contain a where clause are collected
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o Log Attribute Parsing: Each entry must have one of the following meta key indicators present:
ip.src, ip.dst, ip.addr, device.ip, alias.ip, alias.host, paddr, sessionid, domain.dst, or
domain.src. If so, meta keys and meta values from the entry will be collected.

Note: Once the above criteria is met, NetWitness Platform sends all the meta keys and values from
the query to the cloud—mnot just the meta key indicators.

The log report is sent in JSON format, over SSL. It contains:
o Timestamps

o Live CMS username (sha256)

NetWitness Platformlicense server ID (sha256)

List of SA endpoint IDs (sha256)

o Harvested meta values (MD5 and SHA256 hashed)

Example

This section lists entries from a log, and then the corresponding section of extrapolated data.

Section from a log file:

User admin (session 204298, 10.4.50.60:57454) has issued values (channel 205237) (thread
2332): fieldName=filter idl=1 1d2=23138902 threshold=100000 size=20 flags=sessions,sort-
total, order-descending, ignore-cache where=" (alias.host = 'mail.google.com') && (ip.src =
161.253.31.130) && time=\"2015-12-07 18:08:00\"-\"2015-12-07 21:07:59\""

Data extrapolation with hashing:

{ timestamp: 1452282588000,
session: 204298,
idi: 1,
id2: 23138902,
userName: "8c6976e5b5410415bde908bd4deel5dfbl67a9¢873fc4bb8a81f6f2aba48a918",
loggerName: "SDK-Values™,
timeRange: "\“2015-12-87 18:@8:00\"-\"2815-12-087 21:87:59\"",
- metalList: [
-1
metaKey: "alias.host"”,
- properties: {
domain_hint: "mai®**FEEEsE com”,
domain_tld: "com",
md5_value: "be5cab@695415d9363d18ad1345c73eb”,
sha256_value: "3f2728499a4b29460f3e3150df508e06b19%=dfafs8efdos1fac777844d28e452"
}
}s
-1
metaKey: "ip.src”,
- properties: {
md5_value: "@3b81ffdff1@9a85a3dac38dbeclacs9”,
sha256_value: "1d88c6893797c896070bd5470d0026211b515d5deed7c6173771a43719Fa7278"
}
}
]
b
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This section provides troubleshooting instructions for issues faced when using the Live Services module
in NetWitness Platform.

Some Rules Are Invalid for Version 11.x

The rules "NetWitness Incident Management - Alert Details" and "NetWitness Incident Management -
Incident Summary" are not valid for RSA NetWitness Platform version 11.x. Do not deploy these rules
to an 11.x system.

Note: Rules are updated frequently, and the documentation for them is available in the Content space
on RSA Link. For the latest information on Rules, see RSA NetWitness Rules.

OutOfMemoryError on Context Hub Server

Y ou may encounter an OutOfMemoryError on Context Hub server, and the service becomes
unresponsive.

If there are any TAXII feeds configured, Health and Wellness raises alerts when the available heap
memory of Context Hub server is critically low. If the status of Context Hub server is Unhealthy
because of low memory, perform the following steps:

1. Make sure that the feeds Start Date is within 180 days.

2. Check if any TAXII feed is consuming too much disk space. A TAXII feed can consume maximum
of 300 MB. If it consumes more disk space, you must reduce the value in the Remove STIX data
older than field under Advanced Options in the Custom Feed Creation Wizard when you edit a
TAXII feeds.

Note: If the issue still persists, you must execute step 3.

3. To decrease the number of parallel threads available for processing STIX:
a. Goto ADMIN > Services > Context Hub service > View > Explore.
b. In the tree panel, navigate to enrichment/stix/ config.

c. In the right panel, set the stix-query-scheduler-pool-size ficld value to 2. By default the value is
5. This setting controls how many number of threads are allowed to process queries for STIX
data at the same time.

d. Set the taxii-poll-scheduler-pool-size ficld value to 2. By default the value is 5. This setting
controls how many number of threads are allowed to poll TAXII servers at the same time.

e. Restart the Context Hub server.

Troubleshooting Live Connect Threat Data Sharing

This section discusses troubleshooting Live Connect Threat Data Sharing.


https://community.rsa.com/docs/DOC-43419
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Query Log Retrieval Sample

To retrieve a sample of threat intelligence data sent to Live Connect, you must construct a URL by
setting the following parameters:

o sendReport: value is true or false: true to send this report to the Live Connect server. False to
just create the report for viewing. The value defaults to false.

o hashValues: value is true or false: true to hash the values as md5/sha256. False to show values in
clear text — should use only for manual viewing. Defaults to false.

o startDate / endDate: Dates for time boundaries for log entries. Format: YYYY-MM-DD
HH:mm:ss

The following is an example of the URL used to retrieve query logs:

https://<server>/admin/liveconnect/force aggregation?startDate=2016-01-
18%2000:00:00&endDate=2016-01-19%2010:10:00&sendReport=false&hashValues=true

System Logging: Debug

To access debug information:
1. Goto ADMIN > System > System Logging.
2. Select the Settings tab.

3. Inthe Package Configuration section, select com > netwitness > platform > server >
liveconnect > service (DEBUG).
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Info System Logging

Updates
Realtime Historical setings

Licensing

Ernail Package Configuration
Global Motifications B[ investigation *
Legacy Motifications @[list

System Logging B[ Tlive
HB liveconnect

Global Auditing
B service (DEBUG)
Jobs

8 LiveConnectiClient

Live Services U LiveConnectlogAggregatarService

URL Integration ¥ LiveConnectlogParserService
Context Menu Actions ¥ LiveConnectlogRetrievalService
- . [ +] | -
Investigation Elmalware
’ | »
ESA
. Package com.rsasmecsaliveconnectservice
HTTP Proxy Settings
Log Level DEBUG hd

MTP Settings

[ Reset recursively

Log Parser Mappings

2 admin | @BEnglish (United States) | GM
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